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1  Product features

Standard configuration features

Features may vary depending on the model. For support assistance and to learn more about the hardware
and software installed on the computer model, run the HP Support Assistant utility.

Standard configuration features 1
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Front components
00 6O
T——

Item Description

(1) Camera light

(2) Camera

(3) Internal microphone

Bottom components

Item Description
(1) n Memory card reader
() Vent
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Rear panel components

o 6 @0®@®

Item Description Item Description

(1) Optical drive eject button (select products only) (6) Security cable slot

2 Optical drive (select products only) 7 Power cord connector

3) :l : Power button (8) USB 3.0 ports

(0] USB 2.0 ports (2) (9) HDMI port
— Hom

(5) RJ-45 network connector (10) Audio-out (headphone)/Audio-in
‘l"lll' 0 (microphone) combo jack

Rear panel components
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2 lllustrated parts catalog

Computer major components

Item Description

(1 Display panel

2) Card reader/power button board
3) Display bezel

(@) Speaker cover

(5) Graphics card

(6) Hard drive (3.5 in)

2-TB, 7200-rpm

1-TB, 7200-rpm

500-GB, 7200-rpm

(7) Camera module (includes bracket)

Camera shutter (not illustrated)

(8) Fan

9) System board (includes integrated processor; includes replacement thermal material)

Intel® Core i5-8250U
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Item Description
Intel Core i3-8130U
(10) DVD+RW Super-Multi drive
Optical drive bezel (not illustrated)
Optical drive bezel blank (for use in models without an optical drive; not illustrated)
(11) Intel Centrino® Wireless-N 2230, Single Band, 802.11b/g/n, 2x2, Wi-Fi + Bluetooth 4.2 Combo Adapter
(12) Solid-state drives (M.2 2280)
256 GB, PCle
256 GB, TLC, SATA-3
128 GB, PCle
128 GB, TLC, SATA-3
(13) Heat sink (includes replacement thermal material)
(14) Hard drive cover
(15) Rear cover
(16) Speaker Kit (includes left and right speakers and cables)

Memory modules (PC4-2400, SODIMM, 1.2 V; not illustrated)

8-GB

4-GB

Stand assembly (includes caps; not illustrated)

Cables

Description

Low-voltage differential signalling (LVDS) cable

Backlight cable

Hard drive cable

Optical drive cable

Card reader/power board cable

Wireless antenna cables

Camera cable

Cables

5



Miscellaneous parts

Description

Power cord with C5 receptacle, 1.00-meter (3.28-feet)

For use in Argentina

For use in India

For use in the United Kingdom

For use in the United States

AC adapter (65-W HP Smart AC adapter, non-PFC, 7.4 mm)

Keyboard (USB, HP branded)

For use in Latin America

For use in the United States

Keyboard (USB, unbranded)

For use in the Czech Republic

For use in France

For use in Romania

For use in Russia

For use in Saudi Arabia

For use in Turkey

Mouse

HP USB optical mouse

HP USB mouse, hardened

6 Chapter 2 Illlustrated parts catalog



3 Routine care, SATA drive guidelines, and
disassembly preparation

This chapter provides general service information for the computer. Adherence to the procedures and
precautions described in this chapter is essential for proper service.

A CAUTION: When the computer is plugged into an AC power source, voltage is always applied to the system
board. The power cord must be disconnected from the power source before opening the computer to prevent
system board or component damage.

Electrostatic discharge information

A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic device
exposed to electrostatic discharge (ESD) may not appear to be affected at all and can work perfectly
throughout a normal cycle. The device may function normally for a while, but it has been degraded in

the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the discharge
contains enough power to alter device parameters or melt silicon junctions.

Generating static

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities. A product can be degraded by 700 volts.

e Different activities generate different amounts of static electricity.

e  Static electricity increases as humidity decreases.

Relative Humidity

Event 55% 40% 10%
Walking across carpet 7,500V 15,000V 35,000V
Walking across vinyl floor 3,000V 5,000V 12,000V
Motions of bench worker 400V 800V 6,000V
Removing DIPs from plastic tube 400V 700V 2,000V
Removing DIPs from vinyl tray 2,000V 4,000V 11,500V
Removing DIPs from Styrofoam 3,500V 5,000V 14,500V
Removing bubble pack from PCB 7,000V 20,000V 26,500V
Packing PCBs in foam-lined box 5,000V 11,000V 21,000V

Electrostatic discharge information



Preventing electrostatic damage to equipment

Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree of
sensitivity. The following packaging and grounding precautions are necessary to prevent damage to electric
components and accessories.

To avoid hand contact, transport products in static-safe containers such as tubes, bags, or boxes.

Protect all electrostatic-sensitive parts and assemblies with conductive or approved containers
or packaging.

Keep electrostatic-sensitive parts in their containers until they arrive at static-free stations.
Place items on a grounded surface before removing them from their containers.

Always be properly grounded when touching a sensitive component or assembly.

Avoid contact with pins, leads, or circuitry.

Place reusable electrostatic-sensitive parts from assemblies in protective packaging or
conductive foam.

Personal grounding methods and equipment

Use the following equipment to prevent static electricity damage to equipment:

Wrist straps are flexible straps with a maximum of one-megohm  10% resistance in the ground cords.
To provide proper ground, a strap must be worn snugly against bare skin. The ground cord must be
connected to the banana plug connector on the grounding mat or workstation and fit snugly into it.

Heel straps/Toe straps/Boot straps can be used at standing workstations and are compatible with
most types of shoes or boots. On conductive floors or dissipative floor mats, use them on both feet with
a maximum of one-megohm + 10% resistance between the operator and ground.

Static Shielding Protection Levels

Method Voltage
Antistatic plastic 1,500
Carbon-loaded plastic 7,500
Metallized laminate 15,000

Grounding the work area

To prevent static damage at the work area, observe the following precautions:

Cover the work surface with approved static-dissipative material. Provide a wrist strap connected to
the work surface and use properly grounded tools and equipment.

Use static-dissipative mats, foot straps, or air ionizers to give added protection.

Handle electrostatic-sensitive components, parts, and assemblies by the case or PCB laminate. Handle
them only at static-free work areas.

Turn off power and input signals before inserting and removing connectors or test equipment.
Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.
Keep work area free of nonconductive materials such as ordinary plastic assembly aids and Styrofoam.

Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.
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Recommended materials and equipment

The following grounding equipment is recommended to prevent electrostatic damage:

Antistatic tape

Antistatic smocks, aprons, or sleeve protectors

Conductive bins and other assembly or soldering aids

Conductive foam

Conductive tabletop workstations with ground cords of one-megohm +/- 10% resistance
Static-dissipative table or floor mats with hard ties to ground

Field service kits

Static awareness labels

Wrist straps and footwear straps providing one-megohm +/- 10% resistance
Material handling packages

Conductive plastic bags

Conductive plastic tubes

Conductive tote boxes

Opaque shielding bags

Transparent metallized shielding bags

Transparent shielding tubes

Operating guidelines

To prevent overheating and to help prolong the life of the computer:

Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and cold.

Operate the computer on a sturdy, level surface. Leave a 10.2 cm (4-inch) clearance on all vented sides
of the computer and above the monitor to permit the required airflow.

Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place
the keyboard, with the keyboard feet down, directly against the front of the desktop unit as this also
restricts airflow.

Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other foreign matter
can block the vents and limit the airflow. Be sure to unplug the computer before cleaning the air vents.

Never operate the computer with the cover or side panel removed.

Do not stack computers on top of each other or place computers so near each other that they are subject
to each other’s re-circulated or preheated air.

If the computer is to be operated within a separate enclosure, intake and exhaust ventilation must be
provided on the enclosure, and the same operating guidelines listed above will still apply.

Keep liquids away from the computer and keyboard.

Operating guidelines
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Never cover the ventilation slots on the monitor with any type of material.

Install or enable power management functions of the operating system or other software, including
sleep states.

Routine care

General cleaning safety precautions

1.
2.

3
4
5.
6

Never use solvents or flammable solutions to clean the computer.

Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and then use
the cloth on the component.

Always unplug the computer when cleaning with liquids or damp cloths.
Always unplug the computer before cleaning the keyboard, mouse, or air vents.
Disconnect the keyboard before cleaning it.

Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the computer case

Follow all safety precautions in General cleaning safety precautions on page 10 before cleaning the computer.

To clean the computer case, follow the procedures described below:

To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping the surface
with a cloth or swab dampened with clear water.

For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed; alcohol will evaporate quickly
without leaving a residue.

After cleaning, always wipe the unit with a clean, lint-free cloth.

Occasionally clean the air vents on the computer. Lint and other foreign matter can block the vents and
limit the airflow.

Cleaning the keyboard

Follow all safety precautions in General cleaning safety precautions on page 10 before cleaning the keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Cleaning the computer
case on page 10.

When cleaning debris from under the keys, review all rules in General cleaning safety precautions on page 10
before following these procedures:

A CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from under
the keys.

Visible debris underneath or between the keys may be removed by vacuuming or shaking.

Canned, pressurized air may be used to clean debris from under the keys. Caution should be used as too
much air pressure can dislodge lubricants applied under the wide keys.
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e |f youwant to remove a key, use a specially designed key puller to prevent damage to the keys. This tool
is available through many electronics supply outlets.

A CAUTION: Never remove a wide, level key (like the space bar) from the keyboard. If these keys are
improperly removed or installed, the keyboard may not function properly.

e  (leaning under a key may be done with a swab moistened with isopropyl alcohol and then squeezed out.
Be careful not to wipe away lubricants necessary for proper key functions. Use tweezers to remove any
fibers or dirt in confined areas. Allow the parts to air dry before reassembly.

Cleaning the monitor

e  Wipe the monitor screen with a towelette designed for cleaning monitors or with a clean cloth
moistened with water. Do not use sprays or aerosols directly on the screen; the liquid may seep into
the housing and damage a component. Never use solvents or flammable liquids on the monitor.

e  To clean the monitor body follow the procedures in Cleaning the computer case on page 10.

Cleaning the mouse

Before cleaning the mouse, ensure that the power to the computer is turned off.

e  (lean the mouse ball by first removing the retaining plate and the ball from the housing. Pull out any
debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.

e To clean the mouse body, follow the procedures in Cleaning the computer case on page 10.

Service considerations

Listed below are some of the considerations that you should keep in mind during the disassembly and
assembly of the computer.

Tools and software requirements

To service the computer, you need the following:

e  Torx T-15 screwdriver

e  Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)
e  Phillips #2 screwdriver

° Diagnostics software

Screws

The screws used in the computer are not interchangeable. They may have standard or metric threads and may
be of different lengths. If an incorrect screw is used during the reassembly process, it can damage the unit. HP
strongly recommends that all screws removed during disassembly be kept with the part that was removed,
then returned to their proper locations.

A CAUTION: Metric screws have a black finish. U.S. screws have a silver finish and are used on hard drives only.

CAUTION: As each subassembly is removed from the computer, it should be placed away from the work area
to prevent damage.
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Cables and connectors

Most cables used throughout the unit are flat, flexible cables. These cables must be handled with care to
avoid damage. Apply only the tension required to seat or unseat the cables during insertion or removal from
the connector. Handle cables by the connector whenever possible. In all cases, avoid bending or twisting

the cables, and ensure that the cables are routed in such a way that they cannot be caught or snagged by
parts being removed or replaced.

A CAUTION: When servicing this computer, ensure that cables are placed in their proper location during
the reassembly process. Improper cable placement can damage the computer.

Hard Drives

Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This applies
to failed drives as well as replacement spares.

e [f adrive must be mailed, place the drive in a bubble-pack mailer or other suitable protective packaging
and label the package “Fragile: Handle With Care.”

e Do not remove hard drives from the shipping package for storage. Keep hard drives in their protective
packaging until they are actually mounted in the computer.

e  Avoid dropping drives from any height onto any surface.

e If youare inserting or removing a hard drive, turn off the computer. Do not remove a hard drive while
the computer is on or in standby mode.

e  Before handling a drive, ensure that you are discharged of static electricity. While handling a drive, avoid
touching the connector.

e Do not use excessive force when inserting a drive.
e  Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields

such as monitors or speakers.

Lithium coin cell battery

The battery that comes with the computer provides power to the real-time clock and has a minimum lifetime
of about three years.

See the appropriate removal and replacement chapter for the chassis you are working on in this guide for
instructions on the replacement procedures.

A WARNING! This computer contains a lithium battery. There is a risk of fire and chemical burn if the battery is
handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in water or fire, or
expose it to temperatures higher than 140°F (602C). Do not attempt to recharge the battery.

294

[5f NOTE: Batteries, battery packs, and accumulators should not be disposed of together with general
household waste. In order to forward them for recycling or proper disposal, please use the public collection
system or return them to HP.
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SATA hard drives

Serial ATA Hard Drive Characteristics

Number of pins/conductors in data cable

7/7

Number of pins in power cable

15

Maximum data cable length

39.37in (100 cm)

Data interface voltage differential 400-700 mV
Drive voltages 3.3V,5V,12V
Jumpers for configuring drive N/A

Data transfer rate 6.0 Gb/s

SMART ATA drives

The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for HP personal computers have
built-in drive failure prediction that warns the user or network administrator of an impending failure (crash)

of the hard drive. The SMART drive tracks fault prediction and failure indication parameters such as

reallocated sector count, spin retry count, and calibration retry count. If the drive determines that a failure is

imminent, it generates a fault alert.

SATA hard drives
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4 Removal and replacement procedures

Adherence to the procedures and precautions described in this chapter is essential for proper service. After
completing all necessary removal and replacement procedures, run the Diagnostics utility to verify that all
components operate properly.

[%r NOTE: Not all features listed in this guide are available on all computers.

Preparation for disassembly

A WARNING! Voltage is always present on the system board when the computer is plugged into an active
AC outlet. To avoid possible personal injury and damage to the equipment the power cord should be
disconnected from the computer and/or the AC outlet before opening the computer.

See Routine care, SATA drive guidelines, and disassembly preparation on page 7 for initial safety procedures.

1.  Remove/disengage any security devices that prohibit opening the computer.

2 Remove all removable media, such as compact discs or USB flash drives, from the computer.

3.  Turn off the computer properly through the operating system, then turn off any external devices.
q

Disconnect the power cord from the power outlet and disconnect any external devices.

A CAUTION: Turn off the computer before disconnecting any cables.

Regardless of the power-on state, voltage is always present on the system board as long as the system
is plugged into an active AC outlet. In some systems the cooling fan is on even when the computer is in
the “Standby,” or “Suspend” modes. The power cord should always be disconnected before servicing

a unit.

[%r NOTE: During disassembly, label each cable as you remove it, noting its position and routing. Keep all
screws with the removed components.
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Stand assembly

1.  Prepare the computer for disassembly (see Preparation for disassembly on page 14).

2. Using caution, lay the computer down on a flat surface covered with a soft cloth.

A CAUTION: Before positioning the computer with the display assembly facing down, make sure
the work surface is clear of tools, screws, and any other foreign objects. Failure to follow this caution
can result in damage to the display.

Slide the rubber hinge caps so they are positioned about an inch up the stand (1).
Loosen the captive Phillips screws (2) from under both caps that secure the stand to the computer.

Pry the rectangular plastic hinge cover off the computer (3).

o u s W

Remove the stand from the computer (4).

Reverse this procedure to install the stand assembly.
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Display

1.  Prepare the computer for disassembly (see Preparation for disassembly on page 14).

Remove the stand assembly (see Stand assembly on page 15).

Position the computer with the display facing upward.

Remove the two Phillips screws (1) that secure the speaker cover to the computer.

i & W

Pry along the inside edge of the speaker cover to disengage (2), and then lift the cover off the computer
(3).

6. Remove the four Phillips screws under the speaker cover that secure the display to the computer.

7. Remove the Phillips screw under the stand that secures the display to the computer (1).
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8. Rotate the display up and over and place it facedown next to the computer (2). Note that a cable
connects the display to the computer.

Reverse this procedure to install the display.
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Optical drive

1.  Prepare the computer for disassembly (see Preparation for disassembly on page 14).

2. Remove the stand assembly (see Stand assembly on page 15).

3.  Remove the display (see Display on page 16).

4. Remove the Phillips screw that secures the drive to the computer (1).

5. Slide the drive out of the computer (2).

6. Ifreplacing the optical drive, remove the bracket from the rear of the old drive and install on the new
drive. Remove the Phillips screw that secures the bracket to the rear of the drive, and then remove the
bracket.
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7. Ifitis necessary remove the bezel from the drive, rotate the bezel off the front of the optical drive.

Reverse this procedure to reassemble and install the optical drive.
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Hard drive

1. Prepare the computer for disassembly (see Preparation for disassembly on page 14).

Remove the stand assembly (see Stand assembly on page 15).

Remove the display (see Display on page 16).

Disconnect the two hard drive cables from the system board (1).

i & W

Remove the two Phillips screws that secure the drive cage (2), and then remove the drive cage from the
computer (3).

6. Remove the four Phillips screws from the sides of the hard drive cage (1).

7.  Slide the hard drive out of the drive cage (2).

Reverse this procedure to install the hard drive and hard drive cage.
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Memory module

1.

2
3
4.
5

Prepare the computer for disassembly (see Preparation for disassembly on page 14).

Remove the stand assembly (see Stand assembly on page 15).

Remove the display (see Display on page 16).

Spread the two retention clips outward (1) until the memory module tilts up at a 45-degree angle.

Grasp the edge of the memory module (2), and then gently pull the module out of the slot. Use the same
procedure to remove both memory modules.

A CAUTION: To prevent damage to the memory module, hold the memory module by the edges only. Do

not touch the components on the memory module.

To protect a memory module after removal, place it in an electrostatic-safe container.

Reverse this procedure to install a memory module.

[Q’ IMPORTANT: Memory modules are in a stacked configuration. If only one module is installed it must be in
the bottom memory socket.

Memory module
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WLAN module

A CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless module
authorized for use in the computer by the governmental agency that regulates wireless devices in your
country or region. If you replace the module and then receive a warning message, remove the module to
restore device functionality, and then contact technical support.

1.  Prepare the computer for disassembly (see Preparation for disassembly on page 14).

Remove the stand assembly (see Stand assembly on page 15).

2
3. Remove the display (see Display on page 16).
4

Disconnect the antenna cables from the module (1).

[%f NOTE: Either one or two antenna cables may be connected to the WLAN module.

5. Remove the Phillips M2.0x3.0 screw (2), and then pull the module out of the socket (3).

Reverse this procedure to reassemble and install the WLAN module.
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Optane memory module

@f IMPORTANT: The Optane memory module installs into the same M.2 connector as the solid-state drive.
Both the Optane memory module and the solid-state drive cannot be installed at the same time.

1.  Prepare the computer for disassembly (see Preparation for disassembly on page 14).

Remove the stand assembly (see Stand assembly on page 15).

Remove the display (see Display on page 16).

2
3
4. Remove the two Phillips screws that secure the M.2 module bracket to the system board (1).
5

Remove the bracket from the computer (2).

Reverse this procedure to install the Optane memory module.
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Solid-state drive

[Q’ IMPORTANT: The solid-state drive installs into the same M.2 connector as the Optane memory module.
Both the solid-state drive and the Optane memory module cannot be installed at the same time.

1.

2
3
4.
5

6.

Prepare the computer for disassembly (see Preparation for disassembly on page 14).

Remove the stand assembly (see Stand assembly on page 15).

Remove the display (see Display on page 16).

Remove the two Phillips screws that secure the M.2 module bracket to the system board (1).

Remove the bracket from the computer (2).

Remove the Phillips screw (1), and then pull the drive away from the connector (2).

o

Reverse this procedure to install the solid-state drive.
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Power button/card reader board

1.  Prepare the computer for disassembly (see Preparation for disassembly on page 14).

Remove the stand assembly (see Stand assembly on page 15).

Remove the display (see Display on page 16).

Disconnect the cable from the ZIF connector on the power button/card reader board (1).

i s won

Remove the two Phillips screws (2), and then lift the board out of the computer (3).

Reverse this procedure to install the power button/card reader board.
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Speakers

1.  Prepare the computer for disassembly (see Preparation for disassembly on page 14).

Remove the stand assembly (see Stand assembly on page 15).

Remove the display (see Display on page 16).

2
3
4. Disconnect the speaker cables from the system board (one cable per speaker) (1).
5

Lift the speakers out of the computer (2).

[%’ NOTE: Each speaker has two holes that contain rubber gaskets that help secure the speakers to posts.
Make sure the gaskets are installed properly before installing the speakers.

Reverse this procedure to install the speakers.

26 Chapter 4 Removal and replacement procedures



Fan

1.  Prepare the computer for disassembly (see Preparation for disassembly on page 14).

Remove the stand assembly (see Stand assembly on page 15).

Remove the display (see Display on page 16).

Disconnect the fan cable from the system board (1).

Remove the three Phillips screws that secure the fan to the computer (2).

@ s W N

Lift the fan out of the computer (3).

Reverse this procedure to install the fan.

Fan
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Heat sink

1.  Prepare the computer for disassembly (see Preparation for disassembly on page 14).

Remove the stand assembly (see Stand assembly on page 15).

Remove the display (see Display on page 16).

Remove the fan (see Fan on page 27).

In the order indicated on the heat sink, loosen the six captive Phillips screws (1).

@ uos W

Lift the heat sink out of the computer (2).

Reverse this procedure to install the heat sink.
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Discrete graphics card

1.  Prepare the computer for disassembly (see Preparation for disassembly on page 14).

Remove the stand assembly (see Stand assembly on page 15).

Remove the display (see Display on page 16).

Remove the fan (see Fan on page 27).

Remove the heat sink (see Heat sink on page 28).

Remove the four Phillips screws that secure the card to the system board (1).

Noe v s W

Rotate the front of the card upward, and then pull the card away from the connector and out of the
computer (2).

Reverse this procedure to install the discrete graphics card.
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Camera

1.  Prepare the computer for disassembly (see Preparation for disassembly on page 14).
2. Remove the stand assembly (see Stand assembly on page 15).

3. Remove the display (see Display on page 16).

4.  Lift the tape from on top of the connector on the camera (1).

5. Disconnect cable from camera (2).

6. Remove the small Phillips screw that secures the shutter (3).

7. Lift the shutter off the camera (4).

8. Remove the two Phillips screws that secure the camera (5).

9. Lift the camera out of the computer (6).

Reverse this procedure to install the camera.
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System board

1.

Noe v s WD

9.

Prepare the computer for disassembly (see Preparation for disassembly on page 14).

Remove the stand assembly (see Stand assembly on page 15).

Remove the display (see Display on page 16).

Remove the hard drive (see Hard drive on page 20).

Remove the fan (see Fan on page 27).

Remove the heat sink (see Heat sink on page 28).

If replacing the system board, make sure to remove the following components from the old system
board and install on the new system board:

e  Memory modules (Memory module on page 21)

e  Solid-state drive (Solid-state drive on page 24) or Optane memory module (Optane memory
module on page 23)

e  WLAN module (WLAN module on page 22)

Disconnect the following cables from the system board:
(1): Camera cable

(2): Left speaker cable

(3): Right speaker cable

(4): Card reader board cable

(5): Hard drive power cable

(6): Hard drive data cable

(7): Optical drive cable

Remove the six Phillips screws that secure the system board to the computer (1).

System board
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10. Lift the system board out of the computer (2).

Reverse this procedure to install the system board.
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Antennas

1.  Prepare the computer for disassembly (see Preparation for disassembly on page 14).

Remove the stand assembly (see Stand assembly on page 15).

Remove the display (see Display on page 16).

Disconnect the antenna cables from the WLAN module (1).

Peel each antenna off the computer (2).

@ s W

Remove the cables from the clips and routing paths inside of the computer (3).

Reverse this procedure to install the antennas.
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Display cables

1.  Prepare the computer for disassembly (see Preparation for disassembly on page 14).

Remove the stand assembly (see Stand assembly on page 15).

Remove the display (see Display on page 16).

2
3
4. Remove the main display cable by lifting the tape from on top of the connector (1).
5

Squeeze the latches on each side of the connector (2), and then pull the cable out of the connector (3).

Disconnect the backlight cable from the display panel (1).
Disconnect the touch cable from the display panel (2).

Remove from the cables from the clips in the bezel (3).

N

Remove the backlight cable (4) and the touch cable (5) from the bezel.

Reverse this procedure to install the display cables.
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Display bezel

1.  Prepare the computer for disassembly (see Preparation for disassembly on page 14).

Remove the stand assembly (see Stand assembly on page 15).

Remove the display (see Display on page 16).

2
3
4. Disconnect the main cable from the display (see Display cables on page 34).
5. Remove the 11 Phillips screws that secure the bezel to the display panel (1).
6

Lift the bezel off the display panel (2).

—
AT —
¥

Reverse this procedure to install the display bezel.
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5 Computer Setup (F10) Utility

Computer Setup (F10) Utilities

Use Computer Setup (F10) Utility to do the following:

Change factory default settings.
Set the system date and time.

Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

Modify the boot order of bootable devices such as hard drives, optical drives, or USB flash media devices.

Enable Quick Boot, which is faster than Full Boot but does not run all of the diagnostic tests run during a
Full Boot. You can set the system to:

m  always Quick Boot (default);
m  periodically Full Boot (from every 1 to 30 days); or
m  always Full Boot.

Select Post Messages Enabled or Disabled to change the display status of Power-0n Self-Test (POST)
messages. Post Messages Disabled suppresses most POST messages, such as memory count, product
name, and other non-error text messages. If a POST error occurs, the error is displayed regardless of the
mode selected. To manually switch to Post Messages Enabled during POST, press any key (except F1
through F12).

Establish an Ownership Tag, the text of which is displayed each time the system is turned on or
restarted.

Enter the Asset Tag or property identification number assigned by the company to this computer.
Enable the power-on password prompt during system restarts (warm boots) as well as during power-on.

Establish a setup password that controls access to the Computer Setup (F10) Utility and the settings
described in this section.

Secure integrated I/0 functionality, including the serial, USB, or parallel ports, audio, or embedded NIC,
so that they cannot be used until they are unsecured.

Enable or disable removable media boot ability.

Solve system configuration errors detected but not automatically fixed during the Power-0n Self-Test
(POST).

Replicate the system setup by saving system configuration information on a USB device and restoring it
on one or more computers.

Execute self-tests on a specified ATA hard drive (when supported by drive).

Enable or disable DriveLock security (when supported by drive).
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Using Computer Setup (F10) Utilities

Computer Setup can be accessed only by turning the computer on or restarting the system. To access the
Computer Setup Utilities menu, complete the following steps:

1. Turnon or restart the computer.
2. Repeatedly press F10 when the monitor light turns green to access the utility.

You can also press Esc to a menu that allows you to access different options available at startup,
including the Computer Setup utility.

[%f NOTE: If youdo not press F10 at the appropriate time, you must restart the computer and again
repeatedly press F10 when the monitor light turns green to access the utility.

3. Achoice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security, Power,
and Advanced.

4. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and down) keys
to select the option you want, then press Enter. To return to the Computer Setup Utilities menu, press
Esc.

5. To apply and save changes, select File > Save Changes and Exit.
e If you have made changes that you do not want applied, select Ignore Changes and Exit.

e  Toreset to factory settings or previously saved default settings (some models), select Apply
Defaults and Exit. This option will restore the original factory system defaults.

['_ﬁ”f NOTE: Not all settings shown in the following sections are available for all models

A CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup (F10) changes
because the CMOS could become corrupted. It is safe to turn off the computer only after exiting the F10 Setup
screen.
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Computer Setup—rFile

[%f NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Option Description

System Information Lists:
e Manufacturer
e Product name
e SKUnumber
e  Serial number
e  System family
e Bornondate
° System board CT number
° BIOS revision
° BIOS date
° Processor type
° Processor speed

e Installed memory size/speed, number of channels (single or dual) (if applicable)

About Displays copyright notice.

System Log Displays the system log.

Set Time and Date Allows you to set system time and date.
Default Setup Save Current Settings as Default

Saves the current system configuration settings as the default.
Restore Factory Settings as Default

Restores the factory system configuration settings as the default.

Apply Defaults and Exit Applies the currently selected default settings and clears any established passwords.

Ignore Changes and Exit  Exits Computer Setup without applying or saving any changes.

Save Changes and Exit Saves changes to system configuration or default settings and exits Computer Setup.
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Computer Setup—Storage

Ej?)y NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Option

Description

Device Configuration

Lists all installed BIOS-controlled storage devices.

When a device is selected, detailed information and options are displayed. The following options may be
presented:

] Hard Disk: Size, model, firmware version, serial number, connector color.
—  M.2:Size, model,
—  SATA1: Size, model

e  CD-ROMr (not included for USB CD-ROM).

Storage Options

SATA Emulation

Allows you to choose how the SATA controller and devices are accessed by the operating system. There
are three supported options: IDE, RAID, and AHCI (default).

CAUTION: SATA emulation changes may prevent access to existing hard drive data and degrade or
corrupt established volumes.

RAID - Allows DOS and boot access to RAID volumes. Use this mode with the RAID device driver loaded in
the operating system to take advantage of RAID features.

AHCI (default option) - Allows operating systems with AHCI device drivers loaded to take advantage of
more advanced features of the SATA controller.

NOTE: The RAID/AHCI device driver must be installed prior to attempting to boot from a RAID/AHCI
volume. If you attempt to boot from a RAID/AHCI volume without the required device driver installed, the
system will crash (blue screen). RAID volumes may become corrupted if they are booted to after disabling
RAID.

Boot Order

Allows you to:

o  UEFIBoot Sources: Specify the order in which UEFI boot sources (such as a internal hard drive, USB
hard drive, USB optical drive, or internal optical drive) are checked for a bootable operating system
image. Each device on the list may be individually excluded from or included for consideration as a
bootable operating system source.

UEFI boot sources always have precedence over legacy boot sources.

e  Legacy Boot Sources: Specify the order in which legacy boot sources (such as a network interface
card, internal hard drive, USB optical drive, or internal optical drive) are checked for a bootable
operating system image. Each device on the list may be individually excluded from or included for
consideration as a bootable operating system source.

Specify the order of attached hard drives. The first hard drive in the order will have priority in the
boot sequence and will be recognized as drive C (if any devices are attached).

NOTE: To drag a device to a preferred place, press Enter. To remove the device from consideration as a
bootable device, press F5.

You can use F5 to disable individual boot items, as well as disable UEFI boot and/or legacy boot.

NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating system has
started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device specified in Boot Order, restart the computer
and press Esc (to access the boot menu) and then F9 (Boot Order), or only F9 (skipping the boot menu)
when the monitor light turns green. After POST is completed, a list of bootable devices is displayed. Use
the arrow keys to select the preferred bootable device and press Enter. The computer then boots from the
selected non-default device for this one time.

Computer Setup (F10) Utilities
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Computer Setup—Security

[%f NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Option Description

Setup Password Allows you to set and enable a setup (administrator) password.

NOTE: If the setup password is set, it is required to change Computer Setup options, flash the ROM, and
make changes to certain plug and play settings under Windows.

Power-0n Password Allows you to set and enable a power-on password. The power-on password prompt appears after a
power cycle or reboot. If the user does not enter the correct power-on password, the unit will not boot.

Password Options Allows you to enable/disable:
(This selection appears ° Lock Legacy Resources (determines whether or not Windows Device Manager is allowed to change
only if a power-on resource settings for serial and parallel ports).

password or setup

password is set.) e  Stringent security (enabling the stringent password disables the ability to reset the password by

moving the jumper on the system board). Default is disabled.

CAUTION: If you enable the stringent security feature and you forget the setup password or the
power-on password, the computer is inaccessible and can no longer be used.

If you lose or forget the password, the system board must be replaced. This scenario is not covered
under warranty.

To prevent the computer from becoming permanently unusable, record your configured setup
password or power-on password in a safe place away from your computer. Without these
passwords, the computer cannot be unlocked.

° Setup Browse Mode (appears if a setup password is set) (allows viewing, but not changing, the F10
Setup Options without entering setup password). Default is enabled.

° Password prompt on F9 & F12 (requires setup password to use these boot functions). Default is
enabled.

° Network Server Mode. Default is disabled.

Device Security Allows you to set Device Available/Device Hidden (default is Device Available) for:
° System audio
NOTE: Set this value to ‘Device hidden’ to disable all system volume.
e  Network controller
NOTE: You must disable AMT before trying to hide the network controller.

e  SATA ports (varies by model)

USB Security Allows you to set Enabled/Disabled (default is Enabled) for:
e  Rear USB Ports

° Internal USB Ports

Slot Security Allows you to disable any M.2 slot. Default is enabled.

Network Boot Enables/disables the computer’s ability to boot from an operating system installed on a network server.
Default is enabled.

System IDs Displays the following:
° Product name.

e  Serial number.
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e Universal Unique Identifier (UUID) number. The UUID can only be updated if the current chassis serial
number is invalid. (These ID numbers are normally set in the factory and are used to uniquely
identify the system.)

° SKU number.
e  System family.
e  Feature byte.

e  BuildID.

Keyboard locale setting for System ID entry.

System Security (these
options are hardware
dependent)

Data Execution Prevention (enable/disable) - Helps prevent operating system security breaches. Default is
enabled.

TPM - A Trusted Platform Module (TPM) is a specialized chip on a computer that stores RSA encryption
keys specific to the host system for hardware authentication. Each TPM chip contains an RSA key pair
called the Endorsement Key (EK).

- TPM Device (available/hidden). Lets you set the Trusted Platform Module as available or hidden. Default
is available.

- TPM state (enable/disable) - Select to enable the TPM.

- Clear TPM (yes/no). Select to reset the TPM to an unowned state. After the TPMis cleared, it is also
turned off. To temporarily suspend TPM operations, turn the TPM off instead of clearing it.

IMPORTANT: Clearing the TPM resets it to factory defaults and turns it off. You will lose all created keys
and data protected by those keys.

Intel Software Guard Extensions (SGX) (enable/disable) - Intel SGX is a set of CPU instruction codes that
allows user-level code to allocate private regions of memory, called enclaves, that are protected from
processes running at higher privilege levels.

Virtuallization Technology (VTx/VTd) (enable/disable) — Enables the virtualization features of the
processor. Changing this setting requires turning the computer off and then back on. Default is disabled.

Restore Security Settings to Factory Settings (Do not reset/Reset) - Resetting to factory defaults will
erase all security keys and leave the device in a disabled state. Changing this setting requires that you
restart the computer. Default is Do not reset.

Secure Boot
Configuration

e  Legacy Support—Enable/Disable. Allows you to turn off all legacy support on the computer,
including booting to DOS, running legacy graphics cards, booting to legacy devices, and so on. If set
to disable, legacy boot options in Storage > Boot Order are not displayed. Default is enabled.

e  Secure Boot—Enable/Disable. Allows you to make sure an operating system is legitimate before
booting to it, making Windows resistant to malicious modification from preboot to full 0OS booting,
preventing firmware attacks. UEFI and Windows Secure Boot only allow code signed by pre-
approved digital certificates to run during the firmware and 0S boot process. Default is disabled.
Secure Boot enabled also sets Legacy Support to disabled.

e  Key Management—This option lets you manage the custom key settings.

- Clear Secure Boot Keys—Don't Clear/Clear. Allows you to delete any previously loaded custom
boot keys. Default is Don't Clear.

- Key Ownership—HP Keys/Custom Keys. Selecting Custom Mode allows you to modify the
contents of the secure boot signature databases and the platform key (PK) that verifies kernels
during system start up, allowing you to use alternative operating systems. Selecting HP Keys
causes the computer boot using the preloaded HP-specific boot keys. Default is HP Keys.

e  Fast Boot—Enable/Disable. Fast boot disables the ability to interrupt boot, such as pressing f keys
to access items before the operating system loads. Default is disabled.

Computer Setup (F10) Utilities
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Computer Setup—Power

[%f NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Option

Description

0S Power Management

° Runtime Power Management— Enable/Disable. Allows certain operating systems to reduce
processor voltage and frequency when the current software load does not require the full
capabilities of the processor. Default is enabled.

° Idle Power Savings—Extended/Normal. Allows certain operating systems to decrease the
processors power consumption when the processor is idle. Default is extended.

Hardware Power
Management

SATA Power Management — Enables or disables SATA bus and/or device power management. Default is
enabled.

Thermal

CPU Fan Speed—-Display current fan speed.

Computer Setup—Advanced
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[%’ NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Option

Heading

Power-0n Options

Allows you to set:

e  POST messages (enable/disable). Enabling this feature will cause the system to display POST error
messages, which are error messages displayed on the monitor during the Power On Self Test if the
BIOS encounters some kind of problem while starting the PC. A POST error message will only display
on screen if the computer is capable of booting this far. If the POST detects an error before this
point, a beep code is generated instead. Default is disabled.

e  After Power Loss (off/on/previous state). Default is Power off. Setting this option to:
—  Power off—causes the computer to remain powered off when power is restored.
—  Power on—causes the computer to power on automatically as soon as power is restored.

- Previous state—causes the computer to power on automatically as soon as power is restored,
if it was on when power was lost.

NOTE: If you turn off power to the computer using the switch on a power strip, you will not be able to
use the suspend/sleep feature or the Remote Management features.

° POST Delay (in seconds). Enabling this feature will add a user-specified delay to the POST process.
This delay is sometimes needed for hard disks on some PCl cards that spin up very slowly, so slowly
that they are not ready to boot by the time POST is finished. The POST delay also gives you more
time to select F10 to enter Computer (F10) Setup. Default is None.

e  Remote Wakeup Boot Source (remote server/local hard drive). Default is Local hard drive.

BIOS Power-On

Allows you to set the computer to turn on automatically at a time you specify.

Bus Options

Allows you to enable or disable:
° PCI SERR# Generation. Default is enabled.

° PCI VGA Palette Snooping, which sets the VGA palette snooping bit in PCl configuration space; only
needed when more than one graphics controller is installed. Default is disabled.

Device Options

Allows you to set:
e Num Lock State at Power-0n (off/on). Default is off.

e  Multi-Processor (enable/disable). Default is enabled.

Chapter 5 Computer Setup (F10) Utility



e  Hyper-Threading (enable/disable). Default is enabled.

e NIC PXE Option ROM Download (enable/disable). Default is enabled.

Recovering the Configuration Settings

This method of recovery requires that you first perform the Save to Removable Media command with the
Computer Setup (F10) Utility before Restore is needed. (See Computer Setup—File on page 38 in the

Computer Setup—File table.)

Ej?)y NOTE: Itis recommended that you save any modified computer configuration settings to a USB flash media
device and save the device for possible future use.

To restore the configuration, insert the USB flash media device with the saved configuration and perform the
Restore from Removable Media command with the Computer Setup (F10) Utility. (See Computer Setup—File

on page 38 in the Computer Setup—File table.)

Recovering the Configuration Settings
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Troubleshooting without diagnostics

This chapter provides information on how to identify and correct minor problems, such as USB devices, hard
drive, graphics, audio, memory, and software problems. If you encounter problems with the computer, refer
to the tables in this chapter for probable causes and recommended solutions.

[%/r NOTE: Forinformation on specific error messages that may appear on the screen during Power-0n Self-Test

(POST) at startup, refer to POST error messages and diagnostic front panel LEDs and audible codes
on page 65.

Safety and comfort

A WARNING! Misuse of the computer or failure to establish a safe and comfortable work environment may

result in discomfort or serious injury. Refer to the Safety & Comfort Guide at http://www.hp.com/ergo for
more information on choosing a workspace and creating a safe and comfortable work environment. For more
information, refer to the Safety & Regulatory Information guide.

Before you call for technical support
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If you are having problems with the computer, try the appropriate solutions below to try to isolate the exact
problem before calling for technical support.

e  Runthe HP diagnostic tool.

e  Run the hard drive self-test in Computer Setup. Refer to Computer Setup (F10) Utility on page 36 for
more information.

e  Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are error
codes that will help you diagnose the problem. Refer to POST error messages and diagnostic front panel
LEDs and audible codes on page 65 for more information.

e If the screenis blank, plug the monitor into a different video port on the computer if one is available. Or,
replace the monitor with a monitor that you know is functioning properly.

e If you are working on a network, plug another computer with a different cable into the network
connection. There may be a problem with the network plug or cable.

e If yourecently added new hardware, remove the hardware and see if the computer functions properly.
e If yourecently installed new software, uninstall the software and see if the computer functions properly.

° Boot the computer to the Safe Mode to see if it will boot without all of the drivers loaded. When booting
the operating system, use “Last Known Configuration.”

e  Refer to the comprehensive online technical support at http://www.hp.com/support.

e  Refer to Helpful hints on page 45 in this guide.

To assist you in resolving problems online, HP Instant Support Professional Edition provides you with self-
solve diagnostics. If you need to contact HP support, use HP Instant Support Professional Edition's online chat
feature. Access HP Instant Support Professional Edition at: http://www.hp.com/go/ispe.

Access the Business Support Center (BSC) at http://www.hp.com/go/bizsupport for the latest online support
information, software and drivers, proactive notification, and worldwide community of peers and HP experts.
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If it becomes necessary to call for technical assistance, be prepared to do the following to ensure that your
service call is handled properly:

Be in front of your computer when you call.

Write down the computer serial number, product ID number, and monitor serial number before calling.
Spend time troubleshooting the problem with the service technician.

Remove any hardware that was recently added to your system.

Remove any software that was recently installed.

Restore the system from the Recovery Disc Set that you created or restore the system to its original
factory condition in System Software Requirement Disks (SSRD).

A CAUTION: Restoring the system will erase all data on the hard drive. Be sure to back up all data files before
running the restore process.

[:;’/f’ NOTE: For sales information and warranty upgrades (Care Packs), call your local authorized service provider
or dealer.

Helpful hints

If you encounter problems with the computer, monitor, or software, see the following list of general
suggestions before taking further action:

Check that the computer and monitor are plugged into a working electrical outlet.

Check that the voltage select switch (some models) is set to the appropriate voltage for your region
(115V or 230V).

Check that the computer is turned on and the white power light is on.
Check that the monitor is turned on and the green monitor light is on.

Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are error
codes that will help you diagnose the problem. Refer to POST error messages and diagnostic front panel
LEDs and audible codes on page 65 for more information.

Turn up the brightness and contrast controls of the monitor if the monitor is dim.
Press and hold any key. If the system beeps, then the keyboard should be operating correctly.
Check all cable connections for loose connections or incorrect connections.

Wake the computer by pressing any key on the keyboard or pressing the power button. If the system
remains in suspend mode, shut down the computer by pressing and holding the power button for at
least four seconds then press the power button again to restart the computer. If the system will not shut
down, unplug the power cord, wait a few seconds, then plug it in again. The computer will restart if it is
set to power on automatically as soon as power is restored in Computer Setup. If it does not restart,
press the power button to start the computer.

Reconfigure the computer after installing a non-plug and play expansion board or other option. See
Solving hardware installation problems on page 57 for instructions.

Be sure that all the needed device drivers have been installed. For example, if you are using a printer,
you need a driver for that model printer.

Remove all bootable media (CD/DVD or USB device) from the system before turning it on.
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e If you have installed an operating system other than the factory-installed operating system, check to be
sure that it is supported on the system.

e |f the system has multiple video sources (embedded, PCl, or PCI-Express adapters) installed (embedded
video on some models only) and a single monitor, the monitor must be plugged into the monitor
connector on the source selected as the primary VGA adapter. During boot, the other monitor connectors
are disabled and if the monitor is connected into these ports, the monitor will not function. You can
select which source will be the default VGA source in Computer Setup.

A CAUTION: When the computer is plugged into an AC power source, there is always voltage applied to

the system board. You must disconnect the power cord from the power source before opening the computer
to prevent system board or component damage.

Solving general problems
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You may be able to easily resolve the general problems described in this section. If a problem persists and you
are unable to resolve it yourself or if you feel uncomfortable about performing the operation, contact an
authorized dealer or reseller.

A WARNING! When the computer is plugged into an AC power source, voltage is always applied to the system

board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to disconnect
the power cord from the wall outlet and allow the internal system components to cool before touching.

Cannot access the Computer Setup (F10) Utility when booting the computer.

Cause Solution

The Computer Setup (F10) Utility is set to “fast boot” causing Before turning on the computer, press and hold F10. Turn on

the F10 access screen to display too briefly when booting the computer and continue to hold F10 until the Computer Setup
the computer. (F10) Utility is displayed.

-or-—

Follow the Windows instructions for rebooting the computer into
the Computer Setup (F10) Utility.

Computer appears locked up and will not turn off when the power button is pressed.

Cause Solution

Software control of the power switch is not functional. 1. Press and hold the power button for at least four seconds
until the computer turns off.

2. Disconnect the power cord from the electrical outlet.

Computer will not respond to keyboard or mouse.

Cause Solution

Computer is in Sleep state. To resume from Sleep state, press the power button.

CAUTION: When attempting to resume from Sleep state, do not
hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

System has locked up. Restart computer.
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Computer date and time display is incorrect.

Cause Solution

RTC (real-time clock) battery may need to be replaced. Reset the date and time under Control Panel (Computer Setup
can also be used to update the RTC date and time). If the problem

NOTE: Connecting the computer to a live AC outlet prolongs persists, replace the RTC battery. See the Removal and

the life of the RTC battery. Replacement section for instructions on installing a new battery,
or contact an authorized dealer or reseller for RTC battery
replacement.

To access Control Panel in Windows 10, type control panelin
the taskbar search box, and then select Control Panel.

There is no sound or sound volume is too low.

Cause Solution

System volume may be set low or muted. 1. Check the Computer Setup settings to make sure
the internal system speaker is not muted (this setting does
not affect the external speakers).

2. Make sure the external speakers are properly connected and
powered on and that the speakers' volume control is set
correctly.

3.  Use the system volume control available in the operating
system to make sure the speakers are not muted or to
increase the volume.

Poor performance.
Cause Solution
Processor is too hot. 1. Make sure airflow to the computer is not blocked. Leave a
10.2-cm (4-inch) clearance on all vented sides of
the computer and above the monitor to permit the required
airflow.
2. Make sure fans are connected and working properly (some
fans only operate when needed).
3.  Make sure the processor heat sink is installed properly.
Hard drive is full. Transfer data from the hard drive to create more space on
the hard drive.
Low on memory. Add more memory.
Hard drive fragmented. Defragment hard drive.
Program previously accessed did not release reserved memory Restart the computer.
back to the system.
Virus resident on the hard drive. Run virus protection program.
Too many applications running. 1.  Close unnecessary applications to free up memory.

2.  Add more memory.

3.  Some applications run in the background and can be closed
by right-clicking on their corresponding icons in the task
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Poor performance.

Cause

Solution

tray. To prevent these applications from launching at
startup:

In Windows 10:

a. Typemsconfigin the taskbar search box, and then
select msconfig.

b.  On the Startup tab of the System Configuration Utility,
click Open Task Manager.

¢.  Select applications that you do not want to launch
automatically, and the click Disable.

Some software applications, especially games, are stressful on

the graphics subsystem.

1.

Lower the display resolution for the current application or
consult the documentation that came with the application
for suggestions on how to improve performance by
adjusting parameters in the application.

Add more memory.

Upgrade the graphics solution.

Cause unknown.

Restart the computer.

Computer powered off automatically and the Power LED flashes red four times and then white two times.

Cause

Solution

Processor thermal protection activated:
A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

1.

Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

Open the access panel, press the power button, and see if
the processor fan (or other system fan) spins. If the fan does
not spin, make sure the fan cable is plugged onto the system
board header.

If fan a plugged in and not spinning, replace it.

System does not power on and the LEDs on the front of the computer are not flashing.

Cause

Solution

System unable to power on.

Chapter 6 Troubleshooting without diagnostics

Press and hold the power button for less than 4 seconds. If
the hard drive LED turns white, then:

1.

3.
OR

If equipped with a voltage selector, check that the voltage
selector (located on the rear of the power supply) is set to
the appropriate voltage. Proper voltage setting depends on
your region.

Remove the expansion cards one at a time until the 5V_aux
light on the system board turns on.

Replace the system board.

Press and hold the power button for less than 4 seconds. If
the hard drive LED does not turn on white then:



System does not power on and the LEDs on the front of the computer are not flashing.

Cause Solution

1. Check that the unit is plugged into a working AC outlet.

2. Openthe access panel and check that the power button
cable is properly connected to the system board.

3.  Check that the power supply cables are properly connected
to the system board.

4. Check to seeif the 5V_aux light on the system board is
turned on. If it is turned on, then replace the power button
assembly.

5.  If the 5V_aux light on the system board is off, then replace
the power supply.

6. Replace the system board.

Solving power problems

Computer powered off automatically and the Power LED flashes red two times, once every second, followed by a two second
pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing.) Computer powered off
automatically and the Power LED flashes red four times and then white two times.

Cause

Solution

Processor thermal protection activated:

A fan may be blocked or not turning.

1.

Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

2. Openthe access panel, press the power button, and see if
OR the processor fan (or other system fan) spins. If the fan does
The heat sink is not properly attached to the processor. not spin, make sure the fan cable is plugged onto the system
board header.
3. Iffanaplugged in and not spinning, replace it.
Solving hard drive problems
Hard drive error occurs.
Cause Solution
Hard disk has bad sectors or has failed. 1. InWindows 10, type f£i1e in the taskbar search box, and
then select File Explorer from the list of applications. In
the left column, expand This PC, right-click on a drive, select
Properties, and then select the Tools tab. Under Error
checking click Check.
2. Use a utility to locate and block usage of bad sectors. If

necessary, reformat the hard disk.
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Disk transaction problem.

Cause

Solution

Either the directory structure is bad or there is a problem with a
file.

In Windows 10, type file in the taskbar search box, and then
select File Explorer from the list of applications. In the left
column, expand This PC, right-click on a drive, select Properties,
and then select the Tools tab. Under Error checking click Check.

Drive not found (identified).

Cause

Solution

Cable could be loose.

Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving hardware installation
problems on page 57 section. If the system still does not
recognize the new device, check to see if the device is listed within
Computer Setup. If it is listed, the probable cause is a driver
problem. If it is not listed, the probable cause is a hardware
problem.

If this is a newly installed drive, run the Computer Setup utility
and try adding a POST delay under Advanced > Boot Options.

The device is attached to a SATA port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure Device Available is
selected for the device's SATA port in Advanced > Port Options.

Drive responds slowly immediately after power-up.

Run Computer Setup and increase the POST Delay in Advanced >
Boot Options.

Nonsystem disk/NTLDR missing message.

Cause

Solution

The system is trying to start from the hard drive but the hard
drive may have been damaged.

A Perform Drive Protection System (DPS) testing in system
ROM.

System files missing or not properly installed.

1. Insert bootable media and restart the computer.

2. Boot to the windows installation media and select
the recovery option. If only a restore kit is available, then
select the File Backup Program option, and then restore
the system.

3. Install system files for the appropriate operating system.

Hard drive boot has been disabled in Computer Setup.

Run the Computer Setup utility and enable the hard drive entry in
the Advanced > Boot Options list.

Bootable hard drive is not attached as first in a multi-hard drive
configuration.

If attempting to boot from a hard drive, ensure it is attached to
the system board dark blue SATA connector.

Bootable hard drive is not listed first in the Boot Order.

Run the Computer Setup utility and select Advanced > Boot
Options and ensure the bootable hard drive is listed immediately
under the Hard Drive entry.
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Computer will not boot from hard drive.

Cause

Solution

The device is attached to a SATA port that has been hidden in
Computer Setup.

1. Check SATA cable connections.

2. Runthe Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Advanced > Port
Options.

Boot order is not correct.

Run the Computer Setup utility and change boot sequence in
Advanced > Boot Options.

Hard drive is damaged.

Observe if the front panel Power LED is blinking RED and if any
beeps are heard. See POST error messages and diagnostic front
panel LEDs and audible codes on page 65 to determine possible
causes for the blinking red and beep codes.

See the Worldwide Limited Warranty for terms and conditions.

Computer seems to be locked up.

Cause

Solution

Program in use has stopped responding to commands.

1. Use the task manager to close programs that do not
respond.

2. Attempt the normal Windows “Shut Down” procedure. If this
fails, press the power button for four or more seconds to
turn off the power. To restart the computer, press the power
button again.

Solving media card reader problems

Media card will not work in a digital camera after formatting it in Windows.

Cause

Solution

By default, Windows will format any media card with a capacity
greater than 32MB with the FAT32 format. Some digital cameras

use the FAT (FAT16 & FAT12) format and can not operate with a
FAT32 formatted card.

Either format the media card in the digital camera or select FAT
file system to format the media card in a computer with Windows.

A write-protected or locked error occurs when attempting to write to the media card.

Cause

Solution

Media card is locked. Locking the media card is a safety feature
that prevents writing to and deleting from an SD/Memory
Stick/PRO card.

If using an SD card, make sure that the lock tab located on

the right of the SD card is not in the locked position. If using a
Memory Stick/PRO card, make sure that the lock tab located on
the bottom of the Memory Stick/PRO card is not in the locked
position.

Solving media card reader problems
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Can not write to the media card.

Cause

Solution

The media card is a read-only memory (ROM) card.

Check the manufacturer’s documentation included with your card
to see if it writable. Refer to the previous section for a list of
compatible cards.

Media card is locked. Locking the media card is a safety feature
that prevents writing to and deleting from an SD/Memory
Stick/PRO card.

If using an SD card, make sure that the lock tab located on

the right of the SD card is not in the locked position. If using a
Memory Stick/PRO card, make sure that the lock tab located on
the bottom of the Memory Stick/PRO card is not in the locked
position.

Unable to access data on the media card after inserting it into a slot.

Cause

Solution

The media card is not inserted properly, is inserted in the wrong
slot, or is not supported.

Ensure that the card is inserted properly with the gold contact on
the correct side. The green LED will light if inserted properly.

Do not know how to remove a media card correctly.

Cause

Solution

The computer’s software is used to safely eject the card.

In Windows 10, type f£1 1e in the taskbar search box, and then
select File Explorer from the list of applications. In the left
column, expand This PC, right-click on the corresponding drive
icon, and then select Eject. Pull the card out of the slot.

NOTE: Never remove the card when the green LED is flashing

After installing the media card reader and booting to Windows, the reader and the inserted cards are not recognized by

the computer.

Cause

Solution

The operating system needs time to recognize the device if
the reader was just installed into the computer and you are
turning the PC on for the first time.

Wait a few seconds so that the operating system can recognize
the reader and the available ports, and then recognize the media
inserted in the reader.

After inserting a media card in the reader, the computer attempts to boot from the media card.

Cause

Solution

The inserted media card has boot capability.

1.  If you do not want to boot from the media card, remove it
during boot or do not select the option to boot from
the inserted media card during the boot process.

2. During POST (Power On Self-Test), press F9 to modify
the boot menu.

3. Change the boot sequence in F10 Computer Setup.
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Solving audio problems

If the computer has audio features and you encounter audio problems, see the common causes and solutions

listed in the following table.

Sound cuts in and out.

Cause

Solution

Processor resources are being used by other open applications.

Shut down all open processor-intensive applications.

Sound does not come out of the speaker or headphones.

Cause

Solution

Software volume control is turned down or muted.

Double-click the Speaker icon on the taskbar, then make sure
that Mute is not selected and use the volume slider to adjust
the volume.

Audio is hidden in Computer Setup.

Enable the audio in Computer Setup: Advanced > Built-in Device
Options.

The external speakers are not turned on.

Turn on the external speakers.

The audio device may be connected to the wrong jack.

Ensure that the device is connected to the correct jack on

the computer. The rear audio jack output is the green receptacle.
The speakers should be plugged into the line-out jack and

the headphones should be plugged into the headphone jack.

External speakers plugged into the wrong audio jack on a recently
installed sound card.

See the sound card documentation for proper speaker connection.
The rear audio jack output is the green receptacle.

Headphones or devices connected to the line-out connector mute
the internal speaker.

Turn on and use headphones or external speakers, if connected,
or disconnect headphones or external speakers.

Computer is in Sleep state.

Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state, do not
hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Internal speaker is disabled in Computer Setup.

Enable the internal speaker in Computer Setup. Select Advanced >
Built-in Device Options.

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection (if applicable), so multiple audio devices may be listed
in Device Manager. Make sure the correct device is being used.

To access Device Manager in Windows 10, type device
manager in the taskbar search box, and then select Device
Manager from the list of applications.

Some applications can select which audio output device is used.

Make sure the application has selected the correct audio device.

The operating system controls may be set to use a different audio
device as the default output device than what is expected.

Set the operating system to use the correct audio device.

Solving audio problems
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Sound from headphones is not clear or muffied.

Cause

Solution

Headphones are plugged into the rear audio output connector.
The rear audio output connector is for powered audio devices and
is not designed for headphone use.

Plug the headphones into the headphone connector on the front
of the computer.

Computer appears to be locked up while recording audio.

Cause

Solution

The hard disk may be full.

Before recording, make sure there is enough free space on
the hard disk. You can also try recording the audio file in a
compressed format.

Line-in jack is not functioning properly.

Cause

Solution

Jack has been reconfigured in the audio driver or application
software.

In the audio driver or application software, reconfigure the jack or
set the jack to its default value.

There is no sound or sound volume is too low.

Cause

Solution

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection (if applicable), so multiple audio devices may be listed
in Device Manager. Make sure the correct device is being used.

To access Device Manager in Windows 10, type device
manager in the taskbar search box, and then select Device
Manager from the list of applications.

Some applications can select which audio output device is used.

Make sure the application has selected the correct audio device.

The operating system controls may be set to use a different audio
device as the default output device than what is expected.

Set the operating system to use the correct audio device.

Solving printer problems

If you encounter printer problems, see the documentation that came with the printer and to the common
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causes and solutions listed in the following table.

Printer will not print.

Cause

Solution

Printer is not turned on and online.

Turn the printer on and make sure it is online.

The correct printer drivers for the application are not installed.
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1. Install the correct printer driver for the application.
2. Try printing using the MS-DOS command:

DIR C:\ > [printer port]



Printer will not print.

Cause

Solution

where [printer port] isthe address of the printer being
used. If the printer works, reload the printer driver.

To run MS-DOS commands, press the Windows key + r, type cmd
in the Open box, and then click OK.

If you are on a network, you may not have made the connection
to the printer.

Make the proper network connections to the printer.

Printer may have failed.

Run printer self-test.

Printer will not turn on.

Cause

Solution

The cables may not be connected properly.

Reconnect all cables and check the power cord and electrical
outlet.

Printer prints garbled information.

Cause

Solution

The correct printer driver for the application is not installed.

Install the correct printer driver for the application.

The cables may not be connected properly.

Reconnect all cables.

Printer memory may be overloaded.

Reset the printer by turning it off for one minute, then turn it back
on.

Printer will not print.

Cause

Solution

The printer may be out of paper.

Solving keyboard and mouse problems

If you encounter keyboard or mouse problems, see the documentation that came with the equipment and to
the common causes and solutions listed in the following table.

A wireless keyboard/mouse is not working correctly. Symptoms include lagging mouse movement, jumpy mouse/keyboard, or no
function of mouse/keyboard and external drive.

Cause Solution

Connect the wireless keyboard USB receiver to a USB 2.0 port that
is separated from ports with USB 3.0 devices. If you still
experience interference, you may have to place the connectors
farther apart using an external USB hub.

If your computer is equipped with USB 3.0 ports, connected USB
3.0 devices can interfere with the wireless keyboard USB receiver.
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Keyboard commands and typing are not recognized by the computer.

Cause

Solution

Keyboard connector is not properly connected.

Shut down the computer, reconnect the keyboard to the back of
the computer, and then restart the computer.

Program in use has stopped responding to commands.

Shut down your computer using the mouse and then restart
the computer.

Keyboard needs repairs.

See the Worldwide Limited Warranty for terms and conditions.

Computer is in Sleep state.

Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep date, do not
hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Mouse does not respond to movement or is too slow.

Cause

Solution

Mouse connector is not properly plugged into the back of
the computer.

Shut down the computer using the keyboard.
Windows 10:

1. Press the Ctrl and Esc keys at the same time (or press
the Windows logo key) to display the Start menu.

2.  Usethe arrow keys to scroll to and select the power icon at
the top right on the menu, and then press Enter.

3. Usethearrow keys to select Shut Down, and then press
Enter.

4.  After the shutdown is complete, plug the mouse connector
into the back of the computer (or the keyboard) and restart.

Program in use has stopped responding to commands.

Shut down the computer using the keyboard then restart
the computer.

Mouse may need cleaning.

Remove the roller ball cover on the mouse and clean the internal
components.

Mouse may need repair.

See the Worldwide Limited Warranty for terms and conditions.

Computer is in Sleep state.

Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state, do not
hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Mouse will only move vertically, horizontally, or movement is jerky.

Cause

Solution

Mouse roller ball or the rotating encoder shafts that make contact
with the ball are dirty.

Remove roller ball cover from the bottom of the mouse and clean
the internal components with a mouse cleaning kit available from
most computer stores.
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Solving hardware installation problems

You may need to reconfigure the computer when you add or remove hardware, such as an additional drive or
expansion card. If you install a plug and play device, Windows automatically recognizes the device and
configures the computer. If you install a non-plug and play device, you must reconfigure the computer after
completing installation of the new hardware. In Windows, use the Add Hardware Wizard and follow

the instructions that appear on the screen.

To open the Add Hardware Wizard, open a Command Prompt and open hdwwiz.exe.

A WARNING! When the computer is plugged into an AC power source, voltage is always applied to the system
board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to disconnect
the power cord from the wall outlet and allow the internal system components to cool before touching.

Table 6-1 Solving hardware installation problems

A new device is not recognized as part of the system.

Cause

Solution

Device is not seated or connected properly.

Ensure that the device is properly and securely connected and
that pins in the connector are not bent down.

Cable(s) of new external device are loose or power cables are
unplugged.

Ensure that all cables are properly and securely connected and
that pins in the cable or connector are not bent down.

Power switch of new external device is not turned on.

Turn off the computer, turn on the external device, then turn on
the computer to integrate the device with the computer system.

When the system advised you of changes to the configuration,
you did not accept them.

Reboot the computer and follow the instructions for accepting
the changes.

A plug and play board may not automatically configure when
added if the default configuration conflicts with other devices.

Use Windows Device Manager to deselect the automatic settings
for the board and choose a basic configuration that does not
cause a resource conflict. You can also use Computer Setup to
reconfigure or disable devices to resolve the resource conflict.

To access Device Manager in Windows 10, type device
manager in the taskbar search box, and then select Device
Manager from the list of applications.

USB ports on the computer are disabled in Computer Setup.

Run the Computer Setup utility and ensure that Device available
is selected for appropriate USB ports under Advanced > Port
Options.

Computer will not start.

Cause

Solution

Wrong memory modules were used in the upgrade or memory
modules were installed in the wrong location.

1. Review the documentation that came with the system to
determine if you are using the correct memory modules and
to verify the proper installation.

NOTE: DIMM1 or XMM1 must always be installed. DIMM1
must be installed before DIMM2, and DIMM3 must be
installed before DIMM4.

2. Observe the beeps and LED lights on the front of
the computer. Beeps and flashing LEDs are codes for specific
problems.
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Computer will not start.

Cause

Solution

3. Ifyoustill cannot resolve the issue, contact Customer
Support.

Power LED flashes Red three times and then white two times.

Cause

Solution

Memory is installed incorrectly or is bad.

CAUTION: To avoid damage to the DIMMs or the system board,
you must unplug the computer power cord before attempting to
reseat, install, or remove a DIMM module.

1.  Reseat DIMMs. Power on the system.
2. Replace DIMMs one at a time to isolate the faulty module.

NOTE: DIMM1 or XMM1 must always be installed. DIMM1
must be installed before DIMM2, and DIMM3 must be
installed before DIMM4

3.  Replace third-party memory with HP memory.

4. Replace the system board.

Solving network problems

Some common causes and solutions for network problems are listed in the following table. These guidelines
do not discuss the process of debugging the network cabling.

Table 6-2 Solving network problems

Network driver does not detect network controller.

Cause

Solution

Network controller is disabled.

1. Run Computer Setup and enable network controller.

2.  Enable the network controller in the operating system using
Device Manager.

To access Device Manager in Windows 10, type device
manager in the taskbar search box, and then select Device
Manager from the list of applications.

Incorrect network driver.

Check the network controller documentation for the correct driver
or obtain the latest driver from the manufacturer’s Web site.

Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause

Solution

No active network is detected.

Check cabling and network equipment for proper connection.
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Table 6-2 Solving network problems (continued)
Network status link light never flashes.

NOTE:

The network status light is supposed to flash when there is network activity.

Cause

Solution

Network controller is not set up properly.

Check for the device status within Windows, such as Device
Manager for driver load and the Network Connections applet
within Windows for link status.

To access Device Manager in Windows 10, type device
manager in the taskbar search box, and then select Device
Manager from the list of applications.

Network controller is disabled.

1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system using
Device Manager.

To access Device Manager in Windows 10, type device
manager in the taskbar search box, and then select Device
Manager from the list of applications.

Network driver is not properly loaded.

Reinstall network drivers.

System cannot autosense the network.

Disable auto-sensing capabilities and force the system into
the correct operating mode.

Diagnostics reports a failure.

Cause

Solution

The cable is not securely connected.

Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely attached
to the correct device.

The cable is attached to the incorrect connector.

Ensure that the cable is attached to the correct connector.

There is a problem with the cable or a device at the other end of
the cable.

Ensure that the cable and device at the other end are operating
correctly.

The network controller is defective.

Contact an authorized service provider.

Diagnostics passes, but the computer does not communicate with the network.

Cause

Solution

Network drivers are not loaded, or driver parameters do not
match current configuration.

Make sure the network drivers are loaded and that the driver
parameters match the configuration of the network controller.

Make sure the correct network client and protocol is installed.

The network controller is not configured for this computer.

Select the Network and Sharing Center icon in the Control Panel
and configure the network controller.

To access Control Panel in Windows 10, type control panelin
the taskbar search box, and then select Control Panel from
the list of applications.

Solving network problems
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Network controller stopped working when an expansion board was added to the computer.

Cause

Solution

The network controller requires drivers.

Verify that the drivers were not accidentally deleted when
the drivers for a new expansion board were installed.

Network controller stops working without apparent cause.

Cause

Solution

The files containing the network drivers are corrupted.

Reinstall the network drivers using Windows recovery tools in
Windows 10.

If necessary, download the softpaq from the web (from a different
computer).

The cable is not securely connected.

Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely attached
to the correct device.

Cannot connect to network server when attempting Remote System Installation.

Cause

Solution

The network controller is not configured properly.

Verify Network Connectivity, that a DHCP Server is present, and
that the Remote System Installation Server contains the NIC
drivers for your NIC.

System setup utility reports unprogrammed EEPROM.

Cause

Solution

Unprogrammed EEPROM.

Contact an authorized service provider.

Solving memory problems

If you encounter memory problems, some common causes and solutions are listed in the following table.

A CAUTION: Power may still be supplied to the DIMMs when the computer is turned off (depending on
the Management Engine (ME) settings). To avoid damage to the DIMMs or the system board, you must unplug
the computer power cord before attempting to reseat, install, or remove a memory module.

For those systems that support ECC memory, HP does not support mixing ECC and non-ECC memory.
Otherwise, the computer will not boot the operating system.

[%’/r NOTE: The memory count will be affected by configurations with the Management Engine (ME) enabled. The
ME uses 8 MB of system memory in single channel mode or 16 MB of memory in dual-channel mode to
download, decompress, and execute the ME firmware for Out-of-Band (00B), third-party data storage, and

other management functions.
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System will not boot or does not function properly after installing additional memory modules.

Cause

Solution

A memory module is not installed in the DIMM1 or XMM1 socket.

Ensure that a memory module is installed in the DIMM1 or XMM1
socket on the system board. This socket must be populated with a
memory module.

Memory module is not the correct type or speed grade for
the system or the new memory module is not seated properly.

Replace module with the correct industry-standard device for
the computer. On some models, ECC and non-ECC memory
modules cannot be mixed.

Out of memory error.

Cause

Solution

You have run out of memory to run the application.

Check the application documentation to determine the memory
requirements.

Memory count during POST is wrong.

Cause

Solution

The memory modules may not be installed correctly.

Check that the memory modules have been installed correctly and
that proper modules are used.

Integrated graphics may use system memory.

No action required.

Insufficient memory error during operation.

Cause

Solution

Too many Terminate and Stay Resident programs (TSRs) are
installed.

Delete any TSRs that you do not need.

You have run out of memory for the application.

Check the memory requirements for the application or add more
memory to the computer.

Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps five times. (Beeps

stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Memory is installed incorrectly or is bad.

1.  Reseat DIMMs. Power on the system.
2. Replace DIMMs one at a time to isolate the faulty module.
3. Replace third-party memory with HP memory.

4. Replace the system board.
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Solving USB flash drive problems

If you encounter USB flash drive problems, common causes and solutions are listed in the following table.

USB flash drive is not seen as a drive letter in Windows.

Cause

Solution

The drive letter after the last physical drive is not available.

Change the default drive letter for the flash drive in Windows.

USB flash drive not found (identified).

Cause

Solution

The device is attached to a USB port that has been hidden in
Computer Setup.

Run the Computer Setup utility and enable USB ports in Advanced
> Port Options.

The device was not properly seated before power-up.

Ensure the device is fully inserted into the USB port before
applying power to the system

System will not boot from USB flash drive.

Cause

Solution

Boot order is not correct.

Run the Computer Setup utility and change boot sequence in
Advanced > Boot Options.

Removable Media Boot is disabled in the Computer Setup utility.

Run the Computer Setup utility and enable booting to removable
media in Advanced > Boot Options. Ensure USB is enabled in
Storage > Boot Order.

The computer boots to DOS after making a bootable flash drive.

Cause

Solution

Flash drive is bootable.

Install the flash drive only after the operating system boots.

Flash drive is defective.

Try a different flash drive.
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Solving connected component problems

If you encounter problems with devices connected to the front panel, refer to the common causes and

solutions listed in the following table.

A USB device, headphone, or microphone is not recognized by the computer.

Cause

Solution

Device is not properly connected.

1. Turn off the computer.

2. Reconnect the device to the front of the computer and
restart the computer.

The device does not have power.

If the USB device requires AC power, be sure one end is connected
to the device and one end is connected to a live outlet.

The correct device driver is not installed.

1. Install the correct driver for the device.

2. You might need to reboot the computer.

The cable from the device to the computer does not work.

1. If possible, replace the cable.

2.  Restart the computer.

The device is not working.

1.  Replace the device.

2.  Restart the computer.

USB ports on the computer are disabled in Computer Setup.

Run the Computer Setup utility and ensure that the USB ports are
set to Enabled in Security > USB Security.

Solving Internet access problems

If you encounter Internet access problems, consult your Internet Service Provider (ISP) or refer to the common

causes and solutions listed in the following table.

Unable to connect to the Internet.

Cause

Solution

Internet Service Provider (ISP) account is not set up properly.

Verify Internet settings or contact your ISP for assistance.

Web browser is not set up properly.

Verify that the Web browser is installed and set up to work with
your ISP.

Cable/DSL modem is not plugged in.

Plug in cable/DSL modem. You should see a “power” LED light on
the front of the cable/DSL modem.

Cable/DSL service is not available or has been interrupted due to
bad weather.

Try connecting to the Internet at a later time or contact your ISP.
(If the cable/DSL service is connected, the “cable” LED light on
the front of the cable/DSL modem will be on.)

The CAT5 UTP cable is disconnected.

Connect the CAT5 UTP cable between the cable modem and
the computers’s RJ-45 connector. (If the connection is good,
the “PC” LED light on the front of the cable/DSL modem will be
on.)

IP address is not configured properly.

Contact your ISP for the correct IP address.

Cookies are corrupted. (A “cookie” is a small piece of information
that a Web server can store temporarily with the Web browser.

Windows 10:

1. Typecontrol panel inthe taskbar search box, and then
select Control Panel from the list of applications.
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Unable to connect to the Internet.

Cause

Solution

This is useful for having the browser remember some specific
information that the Web server can later retrieve.)

2.  Click Internet Options.
3. Inthe Browsing history section, click the Delete button.

4.  Select the Cookies and website data check box and click
the Delete button.

Cannot automatically launch Internet programs.

Cause

Solution

You must log on to your ISP before some programs will start.

Log on to your ISP and launch the desired program.

Solving software problems

Most software problems occur as a result of the following:

e  The application was not installed or configured correctly.

e  Thereis insufficient memory available to run the application.

e Thereis aconflict between applications.

° Be sure that all the needed device drivers have been installed.

e If you have installed an operating system other than the factory-installed operating system, check to be

sure it is supported on the system.

If you encounter software problems, see the applicable solutions listed in the following table.

Computer will not continue and the HP logo does not display.

Cause

Solution

ROM issue - POST error has occurred.

Observe the beeps and LED lights on the front of the computer.
See POST error messages and diagnostic front panel LEDs and
audible codes on page 65 to determine possible causes.

See the Worldwide Limited Warranty for terms and conditions.

“Illegal Operation has Occurred” error message is displayed.

Cause

Solution

Software being used is not Microsoft-certified for your version of
Windows.

Verify that the software is certified by Microsoft for your version
of Windows (see program packaging for this information).

Configuration files are corrupt.

If possible, save all data, close all programs, and restart
the computer.
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7 POST error messages and diagnostic front
panel LEDs and audible codes

This appendix lists the error codes, error messages, and the various indicator light and audible sequences
that you may encounter during Power-0n Self-Test (POST) or computer restart, the probable source of
the problem, and steps you can take to resolve the error condition.

POST Message Disabled suppresses most system messages during POST, such as memory count and non-
error text messages. If a POST error occurs, the screen will display the error message. To manually switch to
the POST Messages Enabled mode during POST, press any key (except F10, F11, or F12). The default mode is
POST Message Disabled.

The speed at which the computer loads the operating system and the extent to which it is tested are
determined by the POST mode selection.

Quick Boot is a fast startup process that does not run all of the system level tests, such as the memory test.
Full Boot runs all of the ROM-based system tests and takes longer to complete.

Full Boot may also be enabled to run every 1 to 30 days on a regularly scheduled basis. To establish
the schedule, reconfigure the computer to the Full Boot Every x Days mode, using Computer Setup.

[% NOTE: For more information on Computer Setup, see Computer Setup (F10) Utility on page 36.

POST numeric codes and text messages

This section covers those POST errors that have numeric codes associated with them. The section also
includes some text messages that may be encountered during POST.

B’ NOTE:  The computer will beep once after a POST text message is displayed on the screen.

Control panel message Description Recommended action
002-Option ROM Checksum Error System ROM or expansion board option ROM 1. Verify the correct ROM.
checksum.

2.  Flash the ROM if needed.

3. If an expansion board was recently added,
remove it to see if the problem remains.

4.  Clear CMOS. (See Password security and
resetting CMOS on page 70.)

5. If the message disappears, there may be a
problem with the expansion card.

6. Replace the system board.

003-System Board Failure DMA or timers. 1. Clear CMOS. (See Password security and
resetting CMOS on page 70.)

2.  Remove expansion boards.

3. Replace the system board.

008—-Microcode Patch Error Processor is not supported by the BIOS. 1. Upgrade BIOS to proper version.

2. Change the processor.

POST numeric codes and text messages
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Control panel message

Description

Recommended action

00A-Product Information Not Valid

The product information programmed into
the system board is missing or invalid.

Use Computer Setup to update this information.

00B-MEBx Module did not checksum correctly

Memory error during POST execution of
the Management Engine (ME) BIOS Extensions
option ROM.

1.  Reboot the computer.

2. Unplug the power cord, re-seat
the memory modules, and reboot
the computer.

3.  If the memory configuration was recently
changed, unplug the power cord, restore
the original memory configuration, and
reboot the computer.

4.  If the error persists, replace the system
board.

100-Front Audio Not Connected

Front audio cable has been detached or
unseated from system board.

Reconnect or replace front audio cable.

2E1-MemorySize Error

Memory amount has changed since the last
boot (memory added or removed).

The system memory size is different from

the last startup. The most common reason is
the removal of memory from the system board.
Press the F1 key to save the memory changes.
If this message persists, verify that

the memory modules are installed correctly.

2E2-Memory Error

Memory module configuration failed during
boot up.

1. Ensure memory modules are correctly
installed.

2. Verify proper memory module type.

3. Remove and replace the identified faulty
memory module(s).

4.  If the error persists after replacing
memory modules, replace the system
board.

2E4-DIMM Configuration Warning

The current memory configuration is not
optimized.

Rearrange the DIMMs so that each channel has
the same amount of memory.

301-Hard Disk 1: SMART Hard Drive Detects
Imminent Failure

Hard drive is about to fail. (Some hard drives
have a hard drive firmware patch that will fix an
erroneous error message.)

1. Determine if hard drive is giving correct
error message. Run the Drive Protection
System test under using F2 Diagnostics
when booting the computer.

2.  Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)

3. Back up contents and replace hard drive.

302-Hard Disk 2: SMART Hard Drive Detects
Imminent Failure

Hard drive is about to fail. (Some hard drives
have a hard drive firmware patch that will fix an
erroneous error message.)

1. Determine if hard drive is giving correct
error message. Run the Drive Protection
System test under using F2 Diagnostics
when booting the computer.

2.  Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)

3. Back up contents and replace hard drive.

309 - 30C: Hard Disk 3—6: SMART Hard Drive
Detects Imminent Failure

Hard drive is about to fail. (Some hard drives
have a hard drive firmware patch that will fix an
erroneous error message.)

1. Determine if hard drive is giving correct
error message. Run the Drive Protection
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Control panel message

Description

Recommended action

System test under using F2 Diagnostics
when booting the computer.

2.  Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)

3.  Back up contents and replace hard drive.

3F0-Boot Device Not Found

Boot device not found.

Insert boot device or load operating system.

3F1-Hard Disk 1 Error

Hard disk 1 error.

1.  Check and/or replace cables.

2.  Clear CMOS. (See Password security and
resetting CMOS on page 70.)

3.  Replace the hard disk drive.

3F2-Hard Disk 2 Error

Hard disk 2 error.

1.  Check and/or replace cables.

2.  Clear CMOS. (See Password security and
resetting CMOS on page 70.)

3. Replace the hard disk drive.

419-0ut of Memory Space for Option ROMs

Recently added PCl expansion card contains an
option ROM too large to download during POST.

A If aPCl expansion card was recently
added, remove it to see if the problem
remains.

41A-Front USB1/USB2 Not Connected

Front USB cable has been detached or unseated
from system board.

Reconnect or replace front USB cable.

500-BIOS Recovery

A system BIOS recovery has occurred.

Not applicable.

800-Keyboard Error

Keyboard failure.

1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing pins.

3.  Ensure that none of the keys are
depressed.

4. Replace keyboard.

801-Keyboard or System Unit Error

Keyboard failure.

1. Reconnect the keyboard with computer
turned off.

2.  Ensure that none of the keys are
depressed.

3. Replace the keyboard.

4. Replace the system board.

900-CPU Fan Not Detected

CPU fan is not connected or may have
malfunctioned.

1. Reseat CPU fan.
2. Reseat fan cable.

3. Replace CPU fan.

901-Chassis, Rear Chassis, or Front Chassis Fan
not Detected

Chassis, rear chassis, or front chassis fan is not
connected or may have malfunctioned.

1. Reseat chassis, rear chassis, or front
chassis fan.

2. Reseat fan cable.

3. Replace chassis, rear chassis, or front
chassis fan.

POST numeric codes and text messages
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Control panel message Description Recommended action

90B-Fan Failure The system has detected that a cooling fan is 1.  Reseat fan.

not operating correctly.
2. Reseat fan cable.

3. Replace fan.

90D-System Temperature Thermal shutdown occurred. The system BIOS Make sure system has proper airflow.
has detected your machine was previously shut
down to avoid overheating. Overheating may
occur if the cooling vents are blocked or
the operating temperature exceeds the system
specifications. The machine should return to
normal operation once the situation is resolved.

90E-Power Supply Fan Not detected Power supply fan is not connected or may have 1.  Reseat power supply fan.

malfunctioned.
2. Reseat fan cable.

3.  Replace power supply fan.

Interpreting system validation diagnostic front panel LEDs and
audible codes

During the system validation phase that occurs at system startup, the BIOS validates the functionality of
the following subsystems and conditions:

e  ACadapter

e  System board power

e  Processor failure

° BIOS corruption

e  Memory failure

e  Graphics failure

e  System board failure

e  BIOS authentication failure

If an error is detected, specific patterns of long and short blinks, accompanied by long and short beeps (where
applicable) are used to identify the error. These patterns will make up a two part code:

e  Major —the category of the error

e  Minor—the specific error within the category

99

B’ NOTE: Single beep/blink codes are not used.

Number of long beeps/blinks Error category
1 Not used

2 BIOS

3 Hardware
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Number of long beeps/blinks Error category

4 Thermal

5 System board

Patterns of blink/beep codes are determined by using the following parameters:

e 1 second pause occurs after the last major blink.

° 2 second pause occurs after the last minor blink.

e  Beep error code sequences occur for the first 5 iterations of the pattern and then stop.

e  Blink error code sequences continue until the computer is unplugged or the power button is pressed.

[Z?’”r NOTE: Not all diagnostic lights and audible codes are available on all models.

The red LED blinks to represent the major error category (long blinks). The white LED blinks to represent

the minor error category (short blinks). For example, ‘3.5’ indicates 3 long red blinks and 5 short white blinks

to communicate the processor is not detected.

Category Major/minor code Description
BIOS 2.2 The main area (DXE) of BIOS has become corrupted and there is no recovery
binary image available.
2.3 The embedded controller policy requires the user to enter a key sequence.
2.4 The embedded controller is checking or recovering the boot block.
Hardware 3.2 The embedded controller has timed out waiting for BIOS to return from
memory initialization.
3.3 The embedded controller has timed out waiting for BIOS to return from
graphics initialization.
3.4 The system board displays a power failure (crowbar).*
3.5 The processor is not detected.*
3.6 The processor does not support an enabled feature.
Thermal 4.2 A processor over temperature condition has been detected.*
43 An ambient temperature over temperature condition has been detected.
4.4 An MXM over temperature condition has been detected.
System board 5.2 The embedded controller cannot find valid firmware.
5.3 The embedded controller has timed out waiting for the BIOS.
5.4 The embedded controller has timed out waiting for BIOS to return from
system board initialization.
5.5 The embedded controller rebooted the system after a possible lockup

condition had been detected through the use of a System Health Timer,
Automated System Recovery Timer, or other mechanism.

* Indicates hardware triggered event; all other events are controlled by the BIOS.

Interpreting system validation diagnostic front panel LEDs and audible codes
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8 Password security and resetting CMO0S

This computer supports security password features, which can be established through the Computer Setup
Utilities menu.

This computer supports two security password features that are established through the Computer Setup
Utilities menu: administrator password and power-on password. When you establish only an administrator
password, any user can access all the information on the computer except Computer Setup. When you
establish only a power-on password, the power-on password is required to access Computer Setup and any
other information on the computer. When you establish both passwords, only the administrator password will
give you access to Computer Setup.

When both passwords are set, the administrator password can also be used in place of the power-on
password as an override to log in to the computer. This is a useful feature for a network administrator.

If you forget one or both passwords, you can clear all passwords by powering off the system, opening
the cover, temporarily removing the CLR_PSWD jumper, and booting once. This will erase the administrator
and power-on passwords. You must restore the jumper to create new passwords.

The computer’s configuration memory (CMOS) stores information about the computer’s configuration.

The CMOS jumper resets CMOS but does not clear the power-on and setup passwords.

A CAUTION: Resetting the CMOS with power removed will reset the BIOS settings to factory defaults. It may
be useful to back up the BIOS settings or save them as custom defaults before resetting them in case they are
needed later. Back up can be performed in Computer Setup or using the BiosConfigUtility tool available from
www.hp.com. See Computer Setup (F10) Utility on page 36 for information on backing up the BIOS settings.

Resetting CMOS resets BIOS settings to default, but does not clear the passwords or affect any of the other
Security settings. On Intel systems with advanced manageability features, resetting CMOS will also partially
unprovision AMT.

A CAUTION: Stringent security is a mode where there is no physical bypass of the password function. If
enabled, removing the password jumper will be ignored. To enable this mode, change the security setting
Clear Password Jumper in Password Policies to Ignore.

If you lose or forget the password when in stringent security mode, the system can only be reset by System
Management Command. This is a way for HP Service and Support to provide a secure method to access

the BIOS and command a password reset for a specifically identified unit under the direction of

the owner. This scenario may not be covered under warranty.

To prevent needing a customer service event to restore access to the system, record your configured
administrator and power-on passwords in a safe place away from your computer.

[%’/f NOTE: You will receive POST error messages after clearing CMOS and rebooting advising you that
configuration changes have occurred. Use Computer Setup to reset any special system setups along with
the date and time.

A CAUTION: Itis important to back up the computer CMOS settings before resetting them in case they are
needed later. Back up is easily done through Computer Setup. See Computer Setup (F10) Utility on page 36 for
information on backing up the CMOS settings.
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Resetting CMOS and/or the password jumper

This computer supports security password features, which can be established through the Computer Setup
Utilities menu.

This computer supports two security password features that are established through the Computer Setup
Utilities menu: administrator password and power-on password. When you establish only an administrator
password, any user can access all the information on the computer except Computer Setup. When you
establish only a power-on password, the power-on password is required to access Computer Setup and any
other information on the computer. When you establish both passwords, only the administrator password will
give you access to Computer Setup.

When both passwords are set, the administrator password can also be used in place of the power-on
password as an override to log in to the computer. This is a useful feature for a network administrator.

If you forget one or both passwords, you can clear all passwords by powering off the system, opening
the cover, temporarily removing the CMOS/PSWD jumper, and booting once. This will erase the administrator
and power-on passwords. You must restore the jumper to create new passwords.

A CAUTION: Resetting the CMOS with power removed will reset the BIOS settings to factory defaults. It may
be useful to back up the BIOS settings or save them as custom defaults before resetting them in case they are
needed later. Back up can be performed in Computer Setup or using the BiosConfigUtility tool available from
www.hp.com. See Computer Setup (F10) Utility on page 36 for information on backing up the BIOS settings.

Resetting CMOS resets BIOS settings to default, but does not clear the passwords or affect any of the other
Security settings. On Intel systems with advanced manageability features, resetting CMOS will also partially
unprovision AMT.

A CAUTION: Stringent security is a mode where there is no physical bypass of the password function. If
enabled, removing the password jumper will be ignored. To enable this mode, change the security setting
Clear Password Jumper in Password Policies to Ignore.

If you lose or forget the password when in stringent security mode, the system can only be reset by System
Management Command. This is a way for HP Service and Support to provide a secure method to access

the BIOS and command a password reset for a specifically identified unit under the direction of

the owner. This scenario may not be covered under warranty.

To prevent needing a customer service event to restore access to the system, record your configured
administrator and power-on passwords in a safe place away from your computer.

[:;’/f’ NOTE: You will receive POST error messages after clearing CMOS and rebooting advising you that
configuration changes have occurred. Use Computer Setup to reset any special system setups along with
the date and time.

To clear CMOS, disable the power-on or administrator password features, or to clear the power-on or
administrator passwords, complete the following steps:
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Shut down the operating system properly, then turn off the computer and any external devices, and
disconnect the power cord from the power outlet.

With the power cord disconnected, press the power button again to drain the system of any residual
power.

A WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to

disconnect the power cord from the wall outlet, and allow the internal system components to cool
before touching.

A CAUTION: When the computer is plugged in, the power supply always has voltage applied to

the system board even when the unit is turned off. Failure to disconnect the power cord can result in
damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object. See the Safety & Regulatory Information guide for more information.

Remove the stand assembly (see Stand assembly on page 15).

Remove the display (see Display on page 16).

Locate the header and jumper labeled CMOS/PSWD.

B NOTE: The password jumper is blue so that it can be easily identified.

v L@ N2

10.
11.
12.
13.
14.

Remove the jumper from pins 1 and 2.
To reset CMOS, place the jumper on pins 3 and 4. To clear passwords, place the jumper on pins 5 and 6.
Replace the access panel and reconnect the external equipment.

Plug in the computer and turn on power. Allow the operating system to start. This clears the current
passwords and disables the password features.

Shut down the computer, unplug the power, and disconnect the external equipment.
Remove the access panel.

Place the jumper on pins 1 and 2.

Replace the access panel.

Reconnect the external equipment and plug in the computer.

Changing a Setup or Power-on password

To change the power-on or setup password, complete the following steps:

1.

Turn on or restart the computer.

To change the Setup password, go to step 2.

To change the Power-on password, go to step 3.

To change the Setup password, as soon as the computer turns on:

- Press the Esc key while “Press the ESC key for Startup Menu” message is displayed.
- Press the F10 key to enter Computer Setup.
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3.  When the key icon appears, type your current password, a slash (/) or alternate delimiter character, your
new password, another slash (/) or alternate delimiter character, and your new password again as
shown:

current password/new password/new password

[%Y NOTE: Type the new password carefully since the characters do not appear on the screen.

4. Press Enter.

The new password will take effect the next time the computer is restarted.

Deleting a Setup or Power-on password

To delete the power-on or setup password, complete the following steps:
1. Turnon or restart the computer.
To delete the Setup password, go to step 2.
To delete the Power-on password, go to step 3.
2. Todelete the Setup password, as soon as the computer turns on:
- Press the Esc key while “Press the ESC key for Startup Menu” message is displayed.
- Press the F10 key to enter Computer Setup.

3. When the key icon appears, type your current password, a slash (/) or alternate delimiter character, your
new password, another slash (/) or alternate delimiter character, and your new password again as
shown:

current password/

4. Press Enter.
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9 Using HP PC Hardware Diagnostics

Using HP PC Hardware Diagnostics Windows

HP PC Hardware Diagnostics Windows is a Windows-based utility that allows you to run diagnostic tests to
determine whether the computer hardware is functioning properly. The tool runs within the Windows
operating system in order to diagnose hardware failures.

If HP PC Hardware Diagnostics Windows is not installed on your computer, first you must download and install
it. To download HP PC Hardware Diagnostics Windows, see Downloading HP PC Hardware Diagnostics
Windows on page 74.

After HP PC Hardware Diagnostics Windows is installed, follow these steps to access it from HP Help and
Support or HP Support Assistant.

1.  Toaccess HP PC Hardware Diagnostics Windows from HP Help and Support:
a. Select the Start button, and then select HP Help and Support.

b. Right-click HP PC Hardware Diagnostics Windows, select More, and then select Run as
administrator.

—or-
To access HP PC Hardware Diagnostics Windows from HP Support Assistant:
a. Type support in the taskbar search box, and then select the HP Support Assistant app.
—or—
Select the question mark icon in the taskbar.
b. Select Troubleshooting and fixes.
¢. Select Diagnestics, and then select HP PC Hardware Diagnostics Windows.

2. When the tool opens, select the type of diagnostic test you want to run, and then follow the on-screen
instructions.

[i?"”f NOTE: If you need to stop a diagnostic test at any time, select Cancel.

3.  When HP PC Hardware Diagnostics Windows detects a failure that requires hardware replacement, a 24-
digit Failure ID code is generated. For assistance in correcting the problem, contact support, and then
provide the Failure ID code.

Downloading HP PC Hardware Diagnostics Windows
e  The HP PC Hardware Diagnostics Windows download instructions are provided in English only.

e  You must use a Windows computer to download this tool because only .exe files are provided.
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Downloading the latest HP PC Hardware Diagnostics Windows version

To download HP PC Hardware Diagnostics Windows, follow these steps:

1. Goto http://www.hp.com/go/techcenter/pcdiags. The HP PC Diagnostics home page is displayed.

2. Inthe HP PC Hardware Diagnostics section, select Download, and then select the installation location:
To run the tool on your computer, download it to the computer desktop.
—or—
To run the tool from a USB flash drive, download it to a USB flash drive.

3. Select Run.

Downloading HP Hardware Diagnostics Windows by product name or number (select products
only)

[% NOTE: For some products, it may be necessary to download the software to a USB flash drive by using the
product name or number.

To download HP PC Hardware Diagnostics Windows by product name or number (select products only), follow
these steps:

1. Go to http://www.hp.com/support.

2. Select Get software and drivers, and then enter the product name or number.

3. Inthe HP PC Hardware Diagnostics section, select Download, and then select the installation location:
To run the tool on your computer, download it to the computer desktop.
—or—
To run the tool from a USB flash drive, download it to a USB flash drive.

4. Select Run.

Installing HP PC Hardware Diagnostics Windows

To install HP PC Hardware Diagnostics Windows, follow these steps:

A Navigate to the folder on your computer or the flash drive where the .exe file was downloaded, double-
click the .exe file, and then follow the on-screen instructions.

Using HP PC Hardware Diagnostics UEFI

HP PC Hardware Diagnostics UEFI (Unified Extensible Firmware Interface) allows you to run diagnostic tests to
determine whether the computer hardware is functioning properly. The tool runs outside the operating
system so that it can isolate hardware failures from issues that are caused by the operating system or other
software components.

If your PC will not boot into Windows, you can use HP PC Hardware Diagnostics UEFI to diagnose hardware
issues.

When HP PC Hardware Diagnostics UEFI detects a failure that requires hardware replacement, a 24-digit
Failure ID code is generated. For assistance in correcting the problem, contact support, and provide the Failure
ID code.

[:?’”r NOTE: To start diagnostics on a convertible computer, your computer must be in notebook mode, and you
must use the attached keyboard.
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r_'%" NOTE: If you need to stop a diagnostic test, press esc.

Starting HP PC Hardware Diagnostics UEFI

To start HP PC Hardware Diagnostics UEFI, follow these steps:
1. Turnon or restart the computer, and quickly press esc.
2. Pressf2.
The BIOS searches three places for the diagnostic tools, in the following order:

a. Connected USB flash drive

Ej?f)y NOTE: To download the HP PC Hardware Diagnostics UEFI tool to a USB flash drive, see
Downloading the latest HP PC Hardware Diagnostics UEFI version on page 76.

b. Harddrive
c. BIOS

3. When the diagnostic tool opens, select the type of diagnostic test you want to run, and then follow the
on-screen instructions.

Downloading HP PC Hardware Diagnostics UEFI to a USB flash drive

Downloading HP PC Hardware Diagnostics UEFI to a USB flash drive can be useful in the following situations:
e  HP PCHardware Diagnostics UEFI is not included in the preinstall image.
e  HP PCHardware Diagnostics UEFI is not included in the HP Tool partition.

e  Thehard drive is damaged.

[%’/r NOTE: The HP PC Hardware Diagnostics UEFI download instructions are provided in English only, and you
must use a Windows computer to download and create the HP UEFI support environment because only .exe
files are provided.

Downloading the latest HP PC Hardware Diagnostics UEFI version

To download the latest HP PC Hardware Diagnostics UEFI version to a USB flash drive:

1.  Goto http://www.hp.com/go/techcenter/pcdiags. The HP PC Diagnostics home page is displayed.

2. Inthe HP PC Hardware Diagnostics UEFI section, select Download UEFI Diagnostics, and then select
Run.

Downloading HP PC Hardware Diagnostics UEFI by product name or number (select products
only)

[%’/r NOTE: For some products, it may be necessary to download the software to a USB flash drive by using the
product name or number.

To download HP PC Hardware Diagnostics UEFI by product name or number (select products only) to a USB
flash drive:

1. Goto http://www.hp.com/support.

2. Enter the product name or number, select your computer, and then select your operating system.

3. Inthe Diagnostics section, follow the on-screen instructions to select and download the specific UEFI
Diagnostics version for your computer.
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Using Remote HP PC Hardware Diagnostics UEFI settings (select
products only)

Remote HP PC Hardware Diagnostics UEFI is a firmware (BIOS) feature that downloads HP PC Hardware
Diagnostics UEFI to your computer. It can then execute the diagnostics on your computer, and it may upload
results to a preconfigured server. For more information on Remote HP PC Hardware Diagnostics UEFI, go to
http://www.hp.com/go/techcenter/pcdiags, and then select Find out more.

Downloading Remote HP PC Hardware Diagnostics UEFI

[Z?’”r NOTE: HP Remote PC Hardware Diagnostics UEFI is also available as a Softpaq that can be downloaded to a
server.

Downloading the latest Remote HP PC Hardware Diagnostics UEFI version

To download the latest Remote HP PC Hardware Diagnostics UEFI version, follow these steps:

1. Goto http://www.hp.com/go/techcenter/pcdiags. The HP PC Diagnostics home page is displayed.

2. Inthe HP PC Hardware Diagnostics UEFI section, select Download Remote Diagnostics, and then select
Run.

Downloading Remote HP PC Hardware Diagnostics UEFI by product name or number

[Z?’”r NOTE: For some products, it may be necessary to download the software by using the product name or
number.

To download HP Remote PC Hardware Diagnostics UEFI by product name or number, follow these steps:

1. Go to http://www.hp.com/support.

2. Select Get software and drivers, enter the product name or number, select your computer, and then
select your operating system.

3. Inthe Diagnostics section, follow the on-screen instructions to select and download the Remote UEFI
version for the product.

Customizing Remote HP PC Hardware Diagnostics UEFI settings

Using the Remote HP PC Hardware Diagnostics setting in Computer Setup (BIOS), you can perform the
following customizations:

e  Setaschedule for running diagnostics unattended. You can also start diagnostics immediately in
interactive mode by selecting Execute Remote HP PC Hardware Diagnostics.

e  Set the location for downloading the diagnostic tools. This feature provides access to the tools from the
HP website or from a server that has been preconfigured for use. Your computer does not require the
traditional local storage (such as a disk drive or USB flash drive) to run remote diagnostics.

e Setalocation for storing the test results. You can also set the user name and password settings used for
uploads.

e Display status information about the diagnostics run previously.
To customize Remote HP PC Hardware Diagnostics UEFI settings, follow these steps:
1. Turnon or restart the computer, and when the HP logo appears, press f10 to enter Computer Setup.

2. Select Advanced, and then select Settings.

Using Remote HP PC Hardware Diagnostics UEFI settings (select products only)
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3. Make your customization selections.
4. Select Main, and then Save Changes and Exit to save your settings.

Your changes take effect when the computer restarts.
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10 Backing up, restoring, and recovering

This chapter provides information about the following processes, which are standard procedure for most
products:

e  Backing up your personal information—You can use Windows tools to back up your personal
information (see Using Windows tools on page 79).

e Creating arestore point—You can use Windows tools to create a restore point (see Using Windows
tools on page 79).

e  (Creating recovery media (select products only)—You can use HP Recovery Manager or HP Cloud
Recovery Download Tool (select products only) to create recovery media (see Creating HP Recovery
media (select products only) on page 79).

e  Restoring and recovery—Windows offers several options for restoring from backup, refreshing the
computer, and resetting the computer to its original state (see Using Windows tools on page 79).

e  Removing the Recovery Partition—To remove the Recovery partition to reclaim hard drive space
(select products only), select the Remove Recovery Partition option of HP Recovery Manager. For more
information, see Removing the HP Recovery partition (select products only) on page 83.

Using Windows tools

M’ IMPORTANT: Windows is the only option that allows you to back up your personal information. Schedule
regular backups to avoid information loss.

You can use Windows tools to back up personal information and create system restore points and recovery
media, allowing you to restore from backup, refresh the computer, and reset the computer to its original
state.

[% NOTE: If computer storage is 32 GB or less, Microsoft System Restore is disabled by default.

For more information and steps, see the Get Help app.

A Select the Start button, and then select the Get Help app.

@”f NOTE: You must be connected to the Internet to access the Get Help app.

Creating HP Recovery media (select products only)

After you have successfully set up the computer, use HP Recovery Manager to create a backup of the HP
Recovery partition on the computer. This backup is called HP Recovery media. In cases where the hard drive is
corrupted or has been replaced, the HP Recovery media can be used to reinstall the original operating system.

To check for the presence of the Recovery partition in addition to the Windows partition, right-click the Start
button, select File Explorer, and then select This PC.

[%”Nf NOTE: If your computer does not list the Recovery partition in addition to the Windows partition, contact
support to obtain recovery discs. Go to http://www.hp.com/support, select your country or region, and then
follow the on-screen instructions.
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On select products, you can use the HP Cloud Recovery Download Tool to create HP Recovery media on a
bootable USB flash drive. For more information, see Using the HP Cloud Recovery Download Tool to create
recovery media on page 81.

Using HP Recovery Manager to create recovery media

[%f NOTE: If you cannot create recovery media yourself, contact support to obtain recovery discs. Go to
http://www.hp.com/support, select your country or region, and then follow the on-screen instructions.

Before you begin

Before you begin, note the following:

e  Only one set of recovery media can be created. Handle these recovery tools carefully, and keep themin a
safe place.

e  HP Recovery Manager examines the computer and determines the required media storage capacity.

e  To create recovery media, use one of the following options:

[%”f NOTE: If the computer does not have a recovery partition, HP Recovery Manager displays the Windows
Create a Recovery Drive feature. Follow the on-screen instructions to create a recovery image on a blank
USB flash drive or hard drive.

—  If your computer has an optical drive with DVD writer capability, be sure to use only high-quality
blank DVD-R, DVD+R, DVD-R DL, or DVD+R DL discs. Do not use rewritable discs such as CD+RW,
DVD+RW, double-layer DVD+RW, or BD-RE (rewritable Blu-ray) discs, which are not compatible
with HP Recovery Manager software.

—  If your computer does not include an integrated optical drive with DVD writer capability, you can
use an external optical drive (purchased separately) to create recovery discs, as described above. If
an external optical drive is used, you must connect it directly to a USB port on the computer. It
cannot be connected to a USB port on an external device, such as a USB hub.

—  To create a recovery flash drive, use a high-quality blank USB flash drive.
° Be sure that the computer is connected to AC power before you begin creating the recovery media.
e  The creation process can take an hour or more. Do not interrupt this process.

e If necessary, you can exit the program before you have finished creating all of the recovery media. HP
Recovery Manager will finish the current DVD or flash drive. The next time you start HP Recovery
Manager, you will be prompted to continue.

Creating the recovery media

To create HP Recovery media using HP Recovery Manager:

M” IMPORTANT: For a tablet with a detachable keyboard, connect the tablet to the keyboard base before
beginning these steps.

1. Type recovery inthe taskbar search box, and then select HP Recovery Manager.
2. Select Create recovery media, and then follow the on-screen instructions.

If you need to recover the system, see Recovering using HP Recovery Manager on page 81.
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Using the HP Cloud Recovery Download Tool to create recovery media

To create HP Recovery media using the HP Cloud Recovery Download Tool:

1. Go to http://www.hp.com/support.

2. Select Software and Drivers, and then follow the on-screen instructions.

Restoring and recovery

Restoring and recovery can be performed using one or more of the following options: Windows tools, HP
Recovery Manager, or the HP Recovery partition.

@ IMPORTANT: Not all methods are available on all products.

Restoring, resetting, and refreshing using Windows tools

Windows offers several options for restoring, resetting, and refreshing the computer. For details, see Using
Windows tools on page 79.

Restoring using HP Recovery Manager and the HP Recovery partition

You can use HP Recovery Manager and the HP Recovery partition (select products only) to restore the
computer to the original factory state:

e  Resolving problems with preinstalled applications or drivers—To correct a problem with a
preinstalled application or driver:

1. Type recovery in the taskbar search box, and then select HP Recovery Manager.
2. Select Reinstall drivers and/or applications, and then follow the on-screen instructions.

e  Using System Recovery—To recover the Windows partition to original factory content, select the
System Recovery option from the HP Recovery partition (select products only) or use the HP Recovery
media. For more information, see Recovering using HP Recovery Manager on page 81. If you have not
already created recovery media, see Creating HP Recovery media (select products only) on page 79.

e  Using Factory Reset (select products only)—Restores the computer to its original factory state by
deleting all information from the hard drive and recreating the partitions and then reinstalling the
operating system and the software that was installed at the factory (select products only). To use the
Factory Reset option, you must use HP Recovery media. If you have not already created recovery media,
see Creating HP Recovery media (select products only) on page 79.

’L%y NOTE: If you have replaced the hard drive in the computer, you can use the Factory Reset option to
install the operating system and the software that was installed at the factory.

Recovering using HP Recovery Manager

You can use HP Recovery Manager software to recover the computer to its original factory state by using the
HP Recovery media that you either created or that you obtained from HP, or by using the HP Recovery
partition (select products only).

If you have not already created HP Recovery media, see Creating HP Recovery media (select products only)
on page 79.

IQ’ IMPORTANT: HP Recovery Manager does not automatically provide backups of your personal data. Before
beginning recovery, back up any personal data that you want to retain. See Using Windows tools on page 79.

Restoring and recovery
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IMPORTANT: Recovery through HP Recovery Manager should be used as a final attempt to correct computer
issues.

[%,’/r NOTE: When you start the recovery process, only the options available for your computer are displayed.

Before you begin, note the following:

e  HP Recovery Manager recovers only software that was installed at the factory. For software not provided
with this computer, you must either download the software from the manufacturer's website or reinstall
the software from the media provided by the manufacturer.

e If the computer hard drive fails, HP Recovery media must be used. This media is created using HP
Recovery Manager. See Creating HP Recovery media (select products only) on page 79.

e If your computer does not allow the creation of HP Recovery media or if the HP Recovery media does not
work, contact support to obtain recovery media. Go to http://www.hp.com/support, select your country
or region, and then follow the on-screen instructions.

Recovering using the HP Recovery partition (select products only)

The HP Recovery partition allows you to perform a system recovery without recovery discs or a recovery USB
flash drive. This type of recovery can be used only if the hard drive is still working.

The HP Recovery partition (select products only) allows System Recovery only.

To start HP Recovery Manager from the HP Recovery partition:

M IMPORTANT: For a tablet with a detachable keyboard, connect the tablet to the keyboard base before
beginning these steps (select products only).

1. Type recovery inthe taskbar search box, select HP Recovery Manager, and then select Windows
Recovery Environment.

_or—-
For computers or tablets with keyboards attached:
A  Press f11 while the computer boots, or press and hold 11 as you press the power button.
For tablets without keyboards:
A Turnon orrestart the tablet, quickly hold down the volume up button, and then select f11.
2. Select Troubleshoot from the boot options menu.

3. Select Recovery Manager, and then follow the on-screen instructions.

[1?? NOTE: If your computer does not automatically restart in HP Recovery Manager, change the computer
boot order, and then follow the on-screen instructions. See Changing the computer boot order

on page 83.

Recovering using HP Recovery media

If your computer does not have an HP Recovery partition or if the hard drive is not working properly, you can
use HP Recovery media to recover the original operating system and software programs that were installed at
the factory.

A Insert the HP Recovery media, and then restart the computer.
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[%9 NOTE: If your computer does not automatically restart in HP Recovery Manager, change the computer
boot order, and then follow the on-screen instructions. See Changing the computer boot order
on page 83.

Changing the computer boot order

If your computer does not restart in HP Recovery Manager, you can change the computer boot order. This is
the order of devices listed in BIOS where the computer looks for startup information. You can change the
selection to an optical drive or a USB flash drive, depending on the location of your HP Recovery media.

To change the boot order:

[Q" IMPORTANT: For a tablet with a detachable keyboard, connect the tablet to the keyboard base before
beginning these steps.

1. Insert the HP Recovery media.
2. Access the system Startup menu.
For computers or tablets with keyboards attached:
A Turnon orrestart the computer or tablet, quickly press esc, and then press f9 for boot options.
For tablets without keyboards:
A Turnon orrestart the tablet, quickly hold down the volume up button, and then select £9.
_or-
Turn on or restart the tablet, quickly hold down the volume down button, and then select f9.

3. Select the optical drive or USB flash drive from which you want to boot, and then follow the on-screen
instructions.

Removing the HP Recovery partition (select products only)

HP Recovery Manager software allows you to remove the HP Recovery partition (select products only) to free
up hard drive space.

[Q" IMPORTANT: After you remove the HP Recovery partition, you will not be able to perform System Recovery
or create HP Recovery media. Before removing the Recovery partition, create HP Recovery media. See
Creating HP Recovery media (select products only) on page 79.

Follow these steps to remove the HP Recovery partition:
1. Type recovery inthe taskbar search box, and then select HP Recovery Manager.

2. Select Remove Recovery Partition, and then follow the on-screen instructions.
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A Batteryreplacement

The battery that comes with the computer provides power to the real-time clock. When replacing the battery,
use a battery equivalent to the battery originally installed in the computer. The computer comes with a 3-volt
lithium coin cell battery.

A WARNING! The computer contains an internal lithium manganese dioxide battery. There is a risk of fire and
burns if the battery is not handled properly. To reduce the risk of personal injury:

Do not attempt to recharge the battery.

Do not expose to temperatures higher than 60°C (140°F).

Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.
Replace the battery only with the HP spare designated for this product.

A CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings. When
the battery is removed or replaced, the CMOS settings will be cleared.

Static electricity can damage the electronic components of the computer or optional equipment. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.

[f}r NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC wall
socket. The lithium battery is only used when the computer is NOT connected to AC power.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and rechargeable
batteries. For more information about recycling programs, go to http://www.hp.com/recycle.

1. Remove/disengage any security devices that prohibit opening the computer.

2 Remove all removable media, such as compact discs or USB flash drives, from the computer.

3.  Turn off the computer properly through the operating system, then turn off any external devices.
q

Disconnect the power cord from the power outlet and disconnect any external devices.

A CAUTION: Regardless of the power-on state, voltage is always present on the system board as long as
the system is plugged into an active AC outlet. You must disconnect the power cord to avoid damage to
the internal components of the computer.

Remove the stand assembly (see Stand assembly on page 15).

Remove the display (see Display on page 16).

Locate the battery and battery holder on the system board.

e

To release the battery from its holder, squeeze the metal clamp that extends above one edge of
the battery. When the battery pops up, lift it out (1).
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9.

10.
11.
12.
13.

To insert the new battery, slide one edge of the replacement battery under the holder’s lip with
the positive side up. Push the other edge down until the clamp snaps over the other edge of the battery
(2).

Replace the access panel.
Plug in the computer and turn on power to the computer.
Reset the date and time, your passwords, and any special system setups using Computer Setup.

Lock any security devices that were disengaged when the access panel was removed.
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Statement of memory volatility

The purpose of this chapter is to provide general information regarding nonvolatile memory in HP Business
computers. This chapter also provides general instructions for restoring nonvolatile memory that can contain
personal data after the system has been powered off and the hard drive has been removed.

HP Business computer products that use Intel®-based or AMD®-based system boards contain volatile DDR
memory. The amount of nonvolatile memory present in the system depends upon the system configuration.
Intel-based and AMD-based system boards contain nonvolatile memory subcomponents as originally shipped
from HP, assuming that no subsequent modifications have been made to the system and assuming that no
applications, features, or functionality have been added to or installed on the system.

Following system shutdown and removal of all power sources from an HP Business computer system,
personal data can remain on volatile system memory (DIMMs) for a finite period of time and will also remain
in nonvolatile memory. Use the steps below to remove personal data from the computer, including the
nonvolatile memory found in Intel-based and AMD-based system boards.

[%f NOTE: If your tablet has a keyboard base, connect to the keyboard base before beginning steps in this

chapter.

Current BIOS steps

86

1.  Follow steps (a) through (1) below to restore the nonvolatile memory that can contain personal data.
Restoring or reprogramming nonvolatile memory that does not store personal data is neither necessary
nor recommended.

1

a. Turnon orrestart the computer, and then press esc while the “Press the ESC key for Startup Menu’
message is displayed at the bottom of the screen.

'L%y NOTE: If the system has a BIOS administrator password, enter the password at the prompt.

b. Select Main, select Apply Factory Defaults and Exit, and then select Yes to load defaults.
The computer will reboot.

¢. During the reboot, press esc while the “Press the ESC key for Startup Menu” message is displayed
at the bottom of the screen.

[’_ﬁ”f NOTE: If the system has a BIOS administrator password, enter the password at the prompt.

d. Select the Security menu, select Restore Security Settings to Factory Defaults, and then select
Yes to restore security level defaults.

The computer will reboot.

e. During the reboot, press esc while the “Press the ESC key for Startup Menu” message is displayed
at the bottom of the screen.

[%”r NOTE: If the system has a BIOS administrator password, enter the password at the prompt.

f.  If anasset or ownership tag is set, select the Security menu and scroll down to the Utilities menu.
Select System IDs, and then select Asset Tracking Number. Clear the tag, and then make the
selection to return to the prior menu.
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g. If aDriveLock password is set, select the Security menu, and scroll down to Hard Drive Utilities
under the Utilities menu. Select Hard Drive Utilities, select DriveLock, then uncheck the checkbox
for DriveLock password on restart. Select OK to proceed.

h. Select the Main menu, and then select Reset BIOS Security to factory default. Click Yes at the
warning message.

The computer will reboot.

i.  During the reboot, press esc while the “Press the ESC key for Startup Menu” message is displayed
at the bottom of the screen.

[ NOTE:  If the system has a BIOS administrator password, enter the password at the prompt.

j-  Select the Main menu, select Apply Factory Defaults and Exit, select Yes to save changes and exit,
and then select Shutdown.

k. Reboot the system. If the system has a Trusted Platform Module (TPM) and/or fingerprint reader,
one or two prompts will appear—one to clear the TPM and the other to Reset Fingerprint Sensor;
press or tap F1 to accept or F2 to reject.

l. Remove all power and system batteries for at least 24 hours.

Complete one of the following:

e  Remove and retain the storage drive.

—or—

e  C(lear the drive contents by using a third party utility designed to erase data from an SSD.
—or—

e  (lear the contents of the drive by using the following BIOS Setup Secure Erase command option
steps:

i IMPORTANT: If you clear data using Secure Erase, it cannot be recovered.

a. Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

b. Select the Security menu and scroll down to the Utilities menu.
c. Select Hard Drive Utilities.

d. Under Utilities, select Secure Erase, select the hard drive storing the data you want to clear, and
then follow the on-screen instructions to continue.
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Nonvolatile memory usage

Does this Does this
memory memory
store retain data What is the
Nonvolatile customer when power purpose of this How is data input into this How is this memory
Memory Type Amount (Size) data? isremoved? memory? memory? write-protected?
HP Sure Start flash 8 MBytes No Yes Provides Data cannot be written to this  This memory is protected
(select models protected device via the host processor. by the HP Sure Start
only) backup of The content is managed Embedded Controller.
critical System  solely by the HP Sure Start
BIOS code, EC Embedded Controller.
firmware, and
critical
computer
configuration
data for select
platforms that
support HP
Sure Start.
For more
information,
see Using HP
Sure Start
(select models
only)
on page 91.
Real Time Clock 256 Bytes No Yes Stores system RTC battery backed-up CMOS  This memory is not write-
(RTC) battery date and time is programmed using the protected.
backed-up CMOS and noncritical  Computer Setup (BIOS), or
configuration data. changing the Microsoft
memory Windows date & time.
Controller (NIC) 64 KBytes (not No Yes Stores NIC NIC EEPROM is programmed A utility is required to
EEPROM customer configuration using a utility from the NIC write data to this memory
accessible) and NIC vendor that can be run from and is available from the
firmware. DOS. NIC vendor. Writing data
to this ROM in an
inappropriate manner will
render the NIC non-
functional.
DIMM Serial 256 Bytes per No Yes Stores memory  DIMM SPD is programmed by ~ Data cannot be written to
Presence Detect memory module the memory vendor. this memory when the
(SPD) module, 128 information. module is installed in a
configuration data  Bytes computer. The specific
programmable write-protection method
(not customer varies by memory vendor.
accessible)
System BIOS 9 MBytes Yes Yes Stores system System BIOS code is NOTE: Writing data to
BIOS code and programmed at the factory. this ROMin an
computer Code is updated when the inappropriate manner can
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configuration
data.

system BIOS is updated.
Configuration data and
settings are input using the
Computer Setup (BIOS) or a
custom utility.

render the computer non-
functional.

A utility is required for
writing data to this
memory and is available
on the HP website; go to
http://www.hp.com
support. Select Find your
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Does this Does this
memory memory
store retain data What is the
Nonvolatile customer whenpower purpose of this How is data input into this How is this memory
Memory Type Amount (Size) data? isremoved? memory? memory? write-protected?
product, and then follow
the on-screen
instructions.
Intel Management 1.5 MBytesor7  Yes Yes Stores Management Engine Codeis  The Intel chipset is
Engine Firmware MBytes Management programmed at the factory. configured to enforce
(present only in Engine Code, Code is updated via Intel hardware protection to
select Elite or Z Settings, secure firmware update block all direct read/write
models. For more Provisioning utility. Unique Provisioning access to this area. An
information, go to Dataand iAMT  Data can be entered at the Intel utility is required for
http://www.hp.com/ third-party data factory or by an updating the firmware.
support. Select store. administrator using the Only firmware updates
Find your Management Engine (MEBXx) digitally signed by Intel
product, and then setup utility. The third party can be applied using this
follow the on- data store contents can be utility.
screen populated by a remote
instructions.) management console or local
applications that have been
registered by an
administrator to have access
to the space.
Bluetooth flash 2 Mbit No Yes Stores Bluetooth flash is A utility is required for
(select products Bluetooth programmed at the factory. writing data to this
only) configuration Tools for writing data to this  memory and is made
and firmware. memory are not publicly available through newer
available but can be obtained  versions of the driver
from the silicon vendor. whenever the flash
requires an upgrade.
802.11 WLAN 4 Kbit to 8 Kbit No Yes Stores 802.11 WLAN EEPROM is A utility is required for
EEPROM configuration programmed at the factory. writing data to this
and calibration  Tools for writing data to this ~ memory and is typically
data. memory are not made public. not made available to the
public unless a firmware
upgrade is necessary to
address a unique issue.
Webcam (select 64 Kbit No Yes Stores webcam  Webcam memory is A utility is required for
products only) configuration programmed using a utility writing data to this
and firmware. from the device memory and is typically
manufacturer that canberun  not made available to the
from Windows. public unless a firmware
upgrade is necessary to
address a unique issue.
Fingerprint reader 512 KByte flash  Yes Yes Stores Fingerprint reader memoryis  Only a digitally signed
(select products fingerprint programmed by user application can make the
only) templates. enrollment in HP call to write to the flash.

ProtectTools Security
Manager.

Nonvolatile memory usage
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Questions and answers
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How can the BIOS settings be restored (returned to factory settings)?

M IMPORTANT: Restore defaults does not securely erase any data on your hard drive. See question and

answer 6 for steps to securely erase data.

Restore defaults does not reset the Custom Secure Boot keys. See question and answer 7 for
information about resetting the keys.

a. Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

b. Select Main, and then select Apply Factory Defaults and Exit.

¢. Follow the on-screen instructions.

d. Select Main, select Save Changes and Exit, and then follow the on-screen instructions.
What is a UEFI BIOS, and how is it different from a legacy BI0S?

The Unified Extensible Firmware Interface (UEFI) BIOS is an industry-standard software interface
between the platform firmware and an operating system (0S). It is a replacement for the older BIOS
architecture, but supports much of the legacy BIOS functionality.

Like the legacy BIOS, the UEFI BIOS provides an interface to display the system information and
configuration settings and to change the configuration of your computer before an 0S is loaded. BIOS
provides a secure run-time environment that supports a Graphic User Interface (GUI). In this
environment, you can use either a pointing device (Touchscreen, TouchPad, pointing stick, or USB
mouse) or the keyboard to navigate and make menu and configuration selections. The UEFI BIOS also
contains basic system diagnostics.

The UEFI BIOS provides functionality beyond that of the legacy BIOS. In addition, the UEFI BIOS works to
initialize the computer’s hardware before loading and executing the 0S; the run-time environment
allows the loading and execution of software programs from storage devices to provide more
functionality, such as advanced hardware diagnostics (with the ability to display more detailed system
information) and advanced firmware management and recovery software.

HP has provided options in Computer Setup (BIOS) to allow you to run in legacy BIOS, if required by the
operating system. Examples of this requirement would be if you upgrade or downgrade the 0S.

Where does the UEFI BIOS reside?
The UEFI BIOS resides on a flash memory chip. A utility is required to write to the chip.

What kind of configuration data is stored on the DIMM Serial Presence Detect (SPD) memory
module? How would this data be written?

The DIMM SPD memory contains information about the memory module, such as size, serial number,
data width, speed/timing, voltage, and thermal information. This information is written by the module
manufacturer and stored on an EEPROM. This EEPROM cannot be written to when the memory module is
installed in a computer. Third-party tools do exist that can write to the EEPROM when the memory
modaule is not installed in a computer. Various third-party tools are available to read SPD memory.

What is meant by “Restore the nonvolatile memory found in Intel-based system boards”?

This message relates to clearing the Real Time Clock (RTC) CMOS memory that contains computer
configuration data.

How can the BIOS security be reset to factory defaults and data erased?

Appendix B Statement of memory volatility



i IMPORTANT: Resetting will result in the loss of information.

These steps will not reset Custom Secure Boot Keys. See question and answer 7 for information about
resetting the keys.

a. Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

b. Select Main, and then select Reset Security to Factory Defaults.

¢. Follow the on-screeninstructions.

d. Select Main, select Save Changes and Exit, and then follow the on-screen instructions.
7. How can the Custom Secure Boot Keys be reset?

Secure Boot is a feature to ensure that only authenticated code can start on a platform. If you enabled
Secure Boot and created Custom Secure Boot Keys, simply disabling Secure Boot will not clear the keys.
You must also select to clear the Custom Secure Boot Keys. Use the same Secure Boot access procedure
you used to create the Custom Secure Boot Keys, but make the selection to clear or delete all Secure
Boot Keys.

a. Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

b. Select the Security menu, select Secure Boot Configuration, and then follow the on-screen
instructions.

¢. Atthe Secure Boot Configuration window, select Secure Boot, select Clear Secure Boot Keys, and
then follow the on-screen instructions to continue.

Using HP Sure Start (select models only)

Select computer models are configured with HP Sure Start, a technology that continuously monitors your
computer's BIOS for attacks or corruption. If the BIOS becomes corrupted or is attacked, HP Sure Start
restores the BIOS to its previously safe state, without user intervention. Those select computer models ship
with HP Sure Start configured and enabled. HP Sure Start is configured and already enabled so that most
users can use the HP Sure Start default configuration. The default configuration can be customized by
advanced users.

To access the latest documentation on HP Sure Start, go to http://www.hp.com/support. Select Find your
product, and then follow the on-screen instructions.

Using HP Sure Start (select models only)
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Power cord set requirements

The power supplies on some computers have external power switches. The voltage select switch feature on
the computer permits it to operate from any line voltage between 100-120 or 220-240 volts AC. Power
supplies on those computers that do not have external power switches are equipped with internal switches
that sense the incoming voltage and automatically switch to the proper voltage.

The power cord set received with the computer meets the requirements for use in the country where you
purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you use
the computer.

General requirements

The requirements listed below are applicable to all countries:

1. The power cord must be approved by an acceptable accredited agency responsible for evaluation in
the country where the power cord set will be installed.

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a nominal voltage
rating of 125 or 250 volts AC, as required by each country’s power system.

3. The diameter of the wire must be a minimum of 0.75 mm, or 18AWG, and the length of the cord must be
between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed uponit or
against it. Particular attention should be paid to the plug, electrical outlet, and the point where the cord exits
from the product.

A WARNING! Do not operate this product with a damaged power cord set. If the power cord set is damaged in

any manner, replace it immediately.

Japanese power cord requirements

For use in Japan, use only the power cord received with this product.

A CAUTION: Do not use the power cord received with this product on any other products.
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Country-specific requirements

Additional requirements specific to a country are shown in parentheses and explained below.

Country Accrediting Agency Country Accrediting Agency
Australia (1) EANSW Italy (1) IMQ

Austria (1) OVE Japan (3) METI

Belgium (1) CEBC Norway (1) NEMKO

Canada (2) CSA Sweden (1) SEMKO

Denmark (1) DEMKO Switzerland (1) SEV

Finland (1) SETI United Kingdom (1) BSI

France (1) UTE United States (2) uL

Germany (1) VDE

1.  The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm, conductor size. Power cord set fittings (appliance coupler and
wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding type
with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the Japanese
Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm, conductor size. Wall plug must be a two-pole
grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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D Specifications

Item Value Value Value
Dimensions Without stand Basic stand Adjustable Height Stand
Width 22.0in (560.0 mm) 22.0in (560.0 mm) 22.0in (560.0 mm)
Depth 1.98in (50.3 mm) 6.0in (153.4 mm) 7.7in(194.8 mm)
Height 15.3in (389 mm) 17.2in (437.2 mm) 20.8in(528.9 mm)
Approximate Weight 19.3 b (8.74 kg)-19.7 lbs 24.11b(10.91kg)-24.5lbs  33.41b(15.17 kg)-33.9 lbs
(8.94 kg) (11.11 kg) (15.37 kg)
Temperature Range
Operating 50° to 95°F (10° to 35°C)
Nonoperating -22° to 140°F (-30° to 60°C)
Relative Humidity (non-
condensing)
3 10-90% at ambient
Operating

X 5-95% at ambient
Non-operating

Maximum Altitude (unpressurized)

Operating 0- 16,404 t (0 - 5,000 m)

Non-operating 0-50,000 ft (0 - 15,240 m)

Power Supply

Rated Voltage Range 100-240V
Rated Line Frequency 50-60 Hz
Max Operating Power 180w

94 Appendix D Specifications



Index

A
antennas

removal and replacement 33
audible codes 68
audio problems 53
audio-in jack, location 3
audio-out jack, location 3

B
backup, creating 79
backups 79
battery

disposal 12
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